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PROPRIETARY NAME

XfreeTM COVID-19 Direct RT-PCR

INTENDED USE

The BioGX XfreeTM COVID-19 Direct RT-PCR (“XfreeTM COVID-19”) is a real-time RT-PCR
test intended for the qualitative detection of nucleic acid from the SARS-CoV-2 virus in
specimens collected in Copan UTMⓇ, Copan ESwabTM, BD UVTTM, VTM or saline (0.85%
NaCl) using nasopharyngeal, nasal, mid-turbinate, and oropharyngeal swab, or
nasopharyngeal wash/aspirates or nasal aspirates obtained from individuals suspected
of COVID-19 by their healthcare provider.

Testing has been validated for analysis of:
a.) direct addition of individual patient sample
b.) extracted nucleic acid addition of individual patient sample
c.) direct addition of pooled patient sample

Results are for the identification of SARS-CoV-2 RNA. The SARS-CoV-2 RNA is generally
detectable in nasopharyngeal, nasal, mid-turbinate, and oropharyngeal swab specimens,
nasopharyngeal wash/aspirates or nasal aspirates during the acute phase of infection.
Positive results are indicative of the presence of SARS-CoV-2 RNA; clinical correlation
with patient history and other diagnostic information is necessary to determine patient
infection status. Positive results do not rule out bacterial infection or co-infection with
other viruses. The agent detected may not be the definite cause of the disease. Negative
results do not preclude SARS-CoV-2 infection and should not be used as the sole basis
for patient management decisions. Negative results must be combined with clinical
observations, patient history, and epidemiological information.

The performance of this test was established based on the evaluation of a limited
number of clinical specimens. Clinical performance has not been established with all
circulating variants but is anticipated to be reflective of the prevalent variants in
circulation at the time and location of the clinical evaluation. Performance at the time of
testing may vary depending on the variants circulating, including newly emerging strains
of SARS-CoV-2 and their prevalence, which change over time.

The BioGX XfreeTM COVID-19 is intended for use by qualified and trained clinical
laboratory personnel specifically instructed and trained in the techniques of real-time
PCR in vitro diagnostic procedures and use of the following real-time PCR instruments:
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-pixlTM Real-Time PCR Platform (software version 1.6.9.0 or later)
-Applied BiosystemsTM QuantStudioTM 5 (0.2 mL 96-well; Design & Analysis
software version 1.5.1 or later)
-Applied BiosystemsTM QuantStudioTM 5, 384-well (Design & Analysis software
version 1.5.1 or later)
-Applied BiosystemsTM 7500 Fast Dx (SDS software version 1.4 or later)
-Bio-Rad CFX96 TouchTM (MaestroTM software version 1.1 or later)
-Bio-Rad CFX384 TouchTM (MaestroTM software version 1.1 or later)
-Bio Molecular Systems Mic Instrument (Mic PCR software version 2.8 or later)

One format of the BioGX XfreeTM COVID-19 assay kit is available:

1. BioGX XfreeTM COVID-19 lyophilized format (REF: 500-003-XMP)

The BioGX XfreeTM COVID-19 lyophilized format assay has been validated utilizing two
different workflows, the direct workflow in which patient sample is added directly to the
BioGX RT-PCR master mix without any pre-processing or extraction steps, and the
non-direct workflow that requires nucleic acid extraction using the QIAGEN QIAamp
Viral RNA Mini Kit. The XfreeTM COVID-19 assay has CE-IVD marking.

Applied BiosystemsTM QuantStudioTM 5, 12K Flex trademarks are the property of ThermoFisher Scientific.

Bio-Rad CFX96 TouchTM and Bio-Rad CFX384 TouchTM trademarks are the property of Bio-Rad Laboratories.

pixlTM Real-Time PCR Platform manufactured by Anitoa Biotechnology and distributed by BioGX.
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SUMMARY AND EXPLANATION

Severe Acute Respiratory Syndrome Coronavirus 2 (SARS-CoV-2) is the novel
betacoronavirus that causes the COVID-19 respiratory disease. The COVID-19 respiratory
disease is transmitted amongst infected humans within populations via respiratory
droplets from talking, coughing, and sneezing1,2. Symptoms of COVID-19 range from mild
illness (dry cough, fatigue, fever, and shortness of breath) to severe illness and death1.

COVID-19 was first identified on December 31, 2019, amongst patients suffering from
pneumonia in Wuhan, China1,2. SARS-CoV-2 is the seventh coronavirus identified as a
human pathogen that likely evolved within an animal host or within humans following
zoonotic transfer3

.

As of April 12, 2022, the WHO has confirmed 497,057,239 infections and 6,179,104
COVID-19 related deaths globally4. The elderly, immunocompromised, and those with
cardiovascular disease, diabetes, and chronic respiratory disease have been shown to be
at higher risk for severe illness1,2. Ahead of global vaccination efforts, patient testing and
social distancing measures mandated by world governments have proven to be the only
way to stem transmission rates5.

BioGX XfreeTM COVID-19 utilizes primer and probe sets based on the United States
Centers for Disease Control and Prevention (US CDC) assay for specific detection of
SARS-CoV-2 (N1 gene region) and human RNase P1,2,6 that serves as an endogenous
Sample Processing Control. Additionally, a non-naturally occurring single-stranded RNA
has been integrated into the master mix to serve as an internal amplification control.

The BioGX XfreeTM COVID-19 multiplex assay is provided in BioGX Sample-ReadyTM

lyophilized format (REF: 500-003-XMP) within 4 x 2 mL vials. Each vial contains all PCR
components such as primers, probes, enzymes, dNTPs, MgCl2, Internal Amplification
Control RNA (IAC), and buffers required for real-time RT-PCR-based testing.
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Individual Patient Samples

BioGX XfreeTM COVID-19 kit (REF: 500-003-XMP) supports testing of individual patient
samples for 104 direct patient samples or 160 extracted/purified nucleic acid samples.
Direct and extracted patient sample analysis has been validated with the following
platforms:

-Applied BiosystemsTM QuantStudioTM 5 (0.2 mL 96-well; Design & Analysis software
version 1.5.1 or later)
-Applied BiosystemsTM QuantStudioTM 5 (384-well; Design & Analysis software version
1.5.1 or later)
-Applied BiosystemsTM 7500 Fast Dx (SDS software version 1.4.1)
-Bio-Rad CFX96 TouchTM (MaestroTM software version 1.1 or later)
-Bio-Rad CFX384 TouchTM (MaestroTM software version 1.1 or later)
-Bio Molecular Systems Mic PCR Instrument (Mic PCR software version 2.8 or later)
-pixlTM Real-Time PCR Platform (software version 1.6.9.0 or later)

Pooled Patient Samples

BioGX XfreeTM COVID-19 kit (REF: 500-003-XMP) supports testing of 52 pooled samples
(52 x 5 patient sample pools per PCR reaction). Pooled sample analysis has been
validated with the following platforms:

-Applied BiosystemsTM QuantStudioTM 5 (0.2 mL 96-well; Design & Analysis software
version 1.5.1 or later)
-Applied BiosystemsTM 7500 Fast Dx (SDS software version 1.4.1)
-Bio-Rad CFX96 TouchTM (MaestroTM software version 1.1 or later)
-pixlTM Real-Time PCR Platform (software version 1.6.9.0 or later)
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Validated Nasopharyngeal and Oropharyngeal Specimen Collection Devices

The following sample types and real-time PCR platforms have been validated for
individual direct patient sample addition when using BioGX XfreeTM COVID-19
lyophilized format:

● Applied BiosystemsTM QuantstudioTM 5 (0.2mL 96-well), Applied BiosystemsTM

QuantstudioTM 5 (384-well), Applied BiosystemsTM 7500 Fast DX, Bio-Rad CFX96
TouchTM, Bio-Rad CFX384 TouchTM, Bio Molecular Mic platform

○ Specimen Collections in:
■ Copan ESwab
■ Copan Universal Transport Media (UTM)
■ BD Universal Viral Transport (UVT)
■ Viral Transport Media (VTM)
■ Dry swab (resuspended in saline (0.85% NaCl))

● pixlTM Real-Time PCR Platform
○ Specimen Collections in:

■ Copan Universal Transport Media (UTM)
■ BD Universal Viral Transport (UVT)
■ Viral Transport Media (VTM)
■ Dry swab (resuspended in saline (0.85% NaCl))

The following sample types and real-time PCR platforms have been validated for pooled
direct patient sample addition when using BioGX XfreeTM COVID-19 lyophilized format:

● Applied BiosystemsTM QuantstudioTM 5 (0.2mL 96-well), Applied BiosystemsTM

7500 Fast DX, Bio-Rad CFX96 TouchTM

○ Specimen Collections in:
■ Copan ESwab
■ Copan Universal Transport Media (UTM)
■ BD Universal Viral Transport (UVT)
■ Viral Transport Media (VTM)
■ Dry swab (resuspended in saline (0.85% NaCl))

● pixlTM Real-Time PCR Platform
○ Specimen Collections in:

■ Copan Universal Transport Media (UTM)
■ BD Universal Viral Transport (UVT)
■ Viral Transport Media (VTM)
■ Dry swab (resuspended in saline (0.85% NaCl))
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The following sample types and real-time PCR platforms have been validated for nucleic
acid extracted individual sample addition when using BioGX XfreeTM COVID-19
lyophilized format:

● Applied BiosystemsTM QuantstudioTM 5 (0.2mL 96-well), Applied BiosystemsTM

QuantstudioTM 5 (384-well), Applied BiosystemsTM 7500 Fast DX, Bio-Rad CFX96
TouchTM, Bio-Rad CFX384 TouchTM, Bio Molecular Mic platform

○ Specimen Collections in:
■ Copan ESwab
■ Copan Universal Transport Media (UTM)
■ BD Universal Viral Transport (UVT)
■ Viral Transport Media (VTM)
■ Dry swab (resuspended in saline (0.85% NaCl))

● pixlTM Real-Time PCR Platform
○ Specimen Collections in:

■ Copan Universal Transport Media (UTM)
■ BD Universal Viral Transport (UVT)
■ Viral Transport Media (VTM)
■ Dry swab (resuspended in saline (0.85% NaCl))
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PRINCIPLES OF THE PROCEDURE

The BioGX XfreeTM COVID-19 is to be used with the Applied BiosystemsTM QuantStudioTM

5 Real-Time PCR System (0.2 mL 96-well and 384-well), Applied BiosystemsTM 7500 Fast
Dx Real-Time PCR Instrument, Bio-Rad CFX96 TouchTM Real-Time PCR Detection System
Bio-Rad CFX384 TouchTM Real-Time PCR Detection System, Bio Molecular Systems Mic, or
pixlTM Real-Time PCR Platform with direct patient sample or extracted patient sample.
The template RNA is reverse transcribed into cDNA and target sequences are PCR
amplified. The amplified target(s) is (are) detected during amplification using hydrolysis
probes labeled at one end with a fluorescent reporter dye (fluorophore) and at the other
end with a quencher moiety. Probes labeled with different fluorophores are used to
detect specific amplicons originating from SARS CoV-2 (N1), RNase P, and Internal
Amplification Control in the following optical channels:

● RNase P FAM equivalent channel
● unused HEX equivalent channel
● SARS-CoV-2 (N1) Texas Red equivalent channel
● Internal Amplification Control Cy 5 equivalent channel
● unused Cy 5.5 equivalent channel

When the probes are in their native state, the fluorescence of the fluorophore is
quenched due to its proximity to the quencher. However, in the presence of their
specific target cDNA, the probes hybridize to their complementary sequences and are
then hydrolyzed by the 5’-3’ exonuclease activity of the DNA polymerase as it
synthesizes the nascent strand along the cDNA template. As a result, the fluorophores
are separated from their quencher molecules and fluorescence is emitted. The amount
of fluorescence detected in the three optical channels used for the BioGX XfreeTM

COVID-19 is directly proportional to the quantity of the corresponding probe that is
hydrolyzed, and therefore generally proportional to the amount of synthesized target.
The Applied BiosystemsTM QuantStudioTM 5 Real-Time PCR System (0.2 mL 96-well and
384-well), Applied BiosystemsTM 7500 Fast Dx Real-Time PCR Instrument, Bio-Rad CFX96
TouchTM Real-Time PCR Detection System, Bio-Rad CFX384 TouchTM Real-Time PCR
Detection System, Bio Molecular Systems Mic, or pixlTM Real-Time PCR Platform
measure these signals at the end of each amplification cycle in real time and interpret
the data to provide a qualitative result for each of the above targets.

A positive result for the detection of target RNA is indicated by the presence of a
real-time PCR growth curve and an associated Ct (Cycle threshold) value.
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REAGENTS PROVIDED

Qty REF Contents No. Tests
Direct
Format

No. Tests
Extracted
Format

No. Tests
Pooled
Format

1 500-003-XMP BioGX XfreeTM COVID-19 Direct
RT-PCR Extraction-Free -
Multi-Platform Sample-ReadyTM

lyophilized PCR Master Mix containing
polymerase, reverse transcriptase,
primers, probes, dNTPs, MgCl2, Internal
Amplification Control RNA (IAC), and
buffers

104 160 52

NOTE: Safety Data Sheets (SDS) are available at www.biogx.com or by request.
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EQUIPMENT AND MATERIALS REQUIRED BUT NOT PROVIDED

● RNA Control (External Control):
o ZeptoMetrix (catalog number: NATSARS(CoV2)-ST) or
o BioGX Synthetic Nucleocapsid Phosphoprotein Gene Region (N1)

(BioGX catalog no. 720-0206).
● Sterile DNase/RNase free 1.5 mL snap cap tubes.
● BioGX Molecular Grade Water or equivalent.

o BioGX Rehydration Water (BioGX catalog number: 800-0035-12)
● Sterile swab collection device appropriate for nasal, nasopharyngeal or

oropharyngeal swab collections.
● Copan universal transport media (UTM) collection kit.
● Copan ESwab collection kit.
● BD universal viral transport (UVT) collection kit.
● Sterile viral transport media (VTM).
● Sterile saline (0.85% NaCl).
● Vortex Genie 2 Vortexer (VWR catalog no. 58815-234) or equivalent.
● Disposable nitrile gloves.
● Optional if using extraction

o QIAGEN QIAamp Viral RNA Mini Kit (Qiagen catalog no. 52906)
o Centrifuge compatible with QIAGEN extraction kit tubes

● Applied BiosystemsTM QuantStudioTM 5 Real-Time PCR System (0.2 mL 96-well)
consumables.

o Thermo Fisher optical 8-tube clear strip (Thermo Fisher catalog no.
4316567)

o Thermo Fisher ultra-clear optical caps, strips of 8 (Thermo Fisher catalog
no. AB-0866)

o Thermo Fisher 96-well optical clear reaction plates (Thermo Fisher
catalog no. A36924)

o Thermo Fisher 96-well qPCR plate seals (Thermo Fisher catalog no.
AB-1170)

● Applied BiosystemsTM QuantStudioTM 5 Real-Time PCR System (384-well)
consumables.

o Thermo Fisher MicroAmp® Endura Plate Optical 384-well Clear Reaction
Plate with Barcode (Thermo Fisher catalog no.: 4483258 or equivalent)

o Thermo Fisher Optical plate seal (Thermo Fisher catalog no. AB0558 or
equivalent)

● Applied BiosystemsTM 7500 Fast Dx Real-Time PCR Instrument (0.1 mL)
consumables.

o Thermo Fisher optical 8-tube clear strip (Thermo Fisher catalog no.
4358293)
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o Thermo Fisher ultra-clear optical caps, strips of 8 (Thermo Fisher catalog
no. 4323032)

o Thermo Fisher 96-well optical reaction plates (Thermo Fisher catalog no.
4346906)

o Thermo Fisher 96-well qPCR plate seals (Thermo Fisher catalog no.
4311971)

● Bio-Rad CFX96 TouchTM Real-Time PCR Detection System consumables.
o Bio-Rad 8-tube white PCR strips without caps (Bio-Rad catalog no.

TLS0851)
o Bio-Rad Optical flat 8-cap strips for PCR tubes (Bio-Rad catalog no.

TCS0803)
o Bio-Rad 96-well white plates (Bio-Rad catalog no. HSP9655)
o Bio-Rad 96-well plate sealing film, optical (Bio-Rad catalog no. MSB1001)

● Bio-Rad CFX384 TouchTM Real-Time PCR Detection System consumables.
o Bio-Rad 384-well clear shell/white well plates (Bio-Rad catalog no.

HSP3905)
o Bio-Rad 384-well plate sealing film, optical (Bio-Rad catalog no. MSB1001)

● Bio Molecular Systems Mic PCR Instrument consumables

o Mic PCR Instrument clear reaction tubes and caps (Bio Molecular Systems
catalog no. 60653)

o Mic PCR Instrument reaction tubes loading block (Bio Molecular Systems
catalog no. 80418)

o Mic PCR Instrument reaction tubes capping tool (Bio Molecular Systems
catalog no. 90690)

● PCR instruments: Applied BiosystemsTM QuantStudioTM 5 Real-Time PCR System
(0.2 mL 96-well and 384-well), Applied BiosystemsTM 7500 Fast Dx Real-Time PCR
Instrument, Bio-Rad CFX96 TouchTM Real-Time PCR Detection System, Bio-Rad
CFX384 TouchTM Real-Time PCR Detection System, Bio Molecular Systems Mic, or
pixlTM Real-Time PCR Platform

● pixlTM Real-Time PCR Platform (BioGX catalog no. 650-016-PXL) Instrument
consumables

o TempAssureⓇ PCR 8-Tube clear strips, Att. Optical Caps (BioGX catalog
no. 010-280-ETS)

● Multi-well Plate Centrifuge (Fisher Mini Plate Spinner catalog no. 14-100-143) or
equivalent

Page 13 of 121 500-003-XMP (CE-IVD) Rev. 09-07APR2023



COVID-19 Direct RT-PCR
Extraction-Free Multiplatform

WARNINGS AND PRECAUTIONS

● For in vitro diagnostic use.
● The XfreeTM COVID-19 assay has been authorized only for the detection of nucleic

acid from SARS-CoV-2, not for any other viruses or pathogens.
● If infection with SARS-CoV-2 is suspected based on current clinical screening criteria

recommended by public health authorities, specimens should be collected with
appropriate infection control precautions.

● Specimen processing should be performed in accordance with national biological
safety regulations.

● Treat all biological specimens as if capable of transmitting infectious agents in
accordance with safe laboratory procedures such as those described in CLSI
Document M297 and in Biosafety in Microbiological and Biomedical Laboratories8.

● Performance characteristics of this test have been established only with the
specimen types listed in the “Intended Use” section. The performance of this assay
with other specimen types or samples has not been evaluated.

● Do not use the reagents if the protective pouches are open or torn upon arrival.
● Close reagent protective pouches promptly with the zip seal after each use. Remove

any excess air in the pouches prior to sealing and store at 2-8 °C.
● Do not remove desiccant from the PCR master mix pouches.
● Do not use master mix if the desiccant is not present or is broken inside the

pouches.
● Do not use reagent vials if they are opened or damaged.
● Do not mix reagents from different pouches and/or kits and/or lots.
● Do not use expired reagents and/or materials.
● Do not pipette by mouth.
● Do not smoke, drink, or eat in areas where specimens or kits are being handled.
● Dispose of unused reagents and waste in accordance with country, federal,

provincial, state, and local regulations.
● Clean and disinfect all surfaces with a 10% bleach solution followed by molecular

grade water.
● Use clean gloves when handling PCR reagents.
● Avoid exposing reagents (lyophilized or rehydrated) to direct sunlight of long-term

ambient lighting.
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STORAGE AND STABILITY

● BioGX recommends long-term storage at 2 to 8°C. Product is stable at a temperature
range of 2-30°C during shipment for 5 days.

● Reagents have been tested to demonstrate optimal performance when stored
properly at 2-8°C and consumed by the expiration date on the kit label.

● Discard unused rehydrated master mix if not used immediately. Re-use may result in
contamination and false results.

● If the pouch is opened by the user but lyophilized reagent is not rehydrated, avoid
exposure of lyophilized reagent to moisture and use the entire contents of the
opened pouch within 1 month.
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SPECIMEN COLLECTION, STORAGE, AND HANDLING

Wear gloves when handling Copan Universal Transport Media (UTM), BD Universal Viral
Transport (UVT), Copan ESwab, VTM or in Saline collected specimens. If gloves come
in contact with the specimen, immediately change gloves to prevent contamination of
other specimens.
 

Collection: Swab specimens should be collected according to the manufacturer’s
instructions for use. Swab specimens should be collected using only swabs with a
synthetic tip, and an aluminum or plastic shaft. Calcium alginate swabs are not
acceptable and cotton swabs with wooden shafts are not recommended.

Place swabs immediately into sterile tubes containing either 3 mL of viral transport
media (UTM, UVT, VTM) or 1 mL of modified liquid Amies media (ESwab).

● Nasopharyngeal swab (NP): Insert a swab into the nostril parallel to the palate.
Swab should reach a depth equal to the distance from the nostrils to the outer
opening of the ear. Leave the swab in place for several seconds to absorb
secretions. Slowly remove the swab while rotating it.

● Oropharyngeal swab (e.g., throat swab, OP): Swab the posterior pharynx,
avoiding the tongue.

● Anterior Nasal Swab (NS): Using a flocked or spun polyester swab, insert the
swab at least 1 cm (0.5 inch) inside the nostril (naris) and firmly sample the nasal
membrane by rotating the swab and leaving in place for 10 to 15 seconds.
Sample both nostrils with the same swab.

Storage: Specimens may be stored at 2-8°C for up to 72 hours after collection. If a delay
in testing or shipping is expected, store specimens at -70°C or below.

Shipping: Specimens must be packaged, shipped, and transported according to the
current edition of the International Air Transport Association (IATA) Dangerous Goods
Regulation. Store specimens at 2-8°C and ship overnight to the lab on an ice pack.
Specimens frozen at -70°C are shipped overnight to the lab on dry ice.

Additional information on packing, shipping, and transporting of specimens can be
found at Interim Laboratory Biosafety Guidelines for Handling and Processing Specimens
Associated with Coronavirus Disease 2019 (COVID-19). For further guidance on
specimen collection, storage and handling from patients suspected to be infected with
SARS-CoV-2,  reference the following CDC Interim Guidelines:
https://www.cdc.gov/coronavirus/2019-nCoV/lab/guidelines-clinical-specimens.html.  
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INSTRUCTIONS FOR USE

Instrument Templates/Protocols and Programming

Applied BiosystemsTM QuantStudioTM 5 Real-Time PCR System (0.2 mL 96-well)
(Operating software: Design & Analysis Software v1.5.1 or later)

Install the BioGX Protocol on the Applied BiosystemsTM QuantStudioTM 5 Real-Time PCR
System (0.2 mL 96-well)
It will be necessary to import the Applied BiosystemsTM QuantStudioTM 5 Real-Time PCR
System template. The most current Applied BiosystemsTM QuantStudioTM 5 Real-Time
PCR System template is available for download at www.biogx.com. Follow the
“Education Center” tab in the navigation menu at the top of the home page. Depending
on your geographical location, select "U.S. Product Documents" or "Int. Product
Documents". Follow the "XfreeTM Direct RT-PCR Documents" tab. Choose the appropriate
product number and follow the "Run Files" link to the platform of choice. Download the
Applied BiosystemsTM QuantStudioTM 5 Real-Time PCR System template. Alternatively,
the Applied BiosystemsTM QuantStudioTM 5 Real-Time PCR System template can also be
obtained by emailing BioGX at info@biogx.com or eu@biogx.com. To manually program
the thermocycler, please refer to Appendix A. For further instrument information,
please refer to the Applied BiosystemsTM QuantStudioTM 5 Real-Time PCR System user
manual9.

Applied BiosystemsTM QuantStudioTM 5 Real-Time PCR System (384-well)
(Operating software: Design & Analysis Software v1.5.1 or later)

Install the BioGX Protocol on the Applied BiosystemsTM QuantStudioTM 5 Real-Time PCR
System, 384-well
It will be necessary to import the Applied BiosystemsTM QuantStudioTM 5 Real-Time PCR
System, 384-well template. The most current Applied BiosystemsTM QuantStudioTM 5
Real-Time PCR System, 384-well template is available for download at www.biogx.com.
Follow the “Education Center” tab in the navigation menu at the top of the home page.
Depending on your geographical location, select "U.S. Product Documents" or "Int.
Product Documents". Follow the "XfreeTM Direct RT-PCR Documents" tab. Choose the
appropriate product number and follow the "Run Files" link to the platform of choice.
Download the Applied BiosystemsTM QuantStudioTM 5 Real-Time PCR System, 384-well
template. Alternatively, the Applied BiosystemsTM QuantStudioTM 5 Real-Time PCR
System, 384-well template can also be obtained by emailing BioGX at info@biogx.com
or eu@biogx.com. To manually program the thermocycler, please refer to Appendix B.
For further instrument information, please refer to the Applied BiosystemsTM

QuantStudioTM 5 Real-Time PCR System, 384-well user manual9.
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Applied BiosystemsTM 7500 Fast Dx Real-Time PCR Instrument
(Operating software: SDS Software v1.4.1)

Install the BioGX Protocol on the Applied BiosystemsTM 7500 Fast Dx Real-Time PCR
Instrument
It will be necessary to import the Applied BiosystemsTM 7500 Fast Dx Real-Time PCR
Instrument template. The most current Applied BiosystemsTM 7500 Fast Dx Real-Time
PCR Instrument template is available for download at www.biogx.com. Follow the
"Education Center" tab in the navigation menu at the top of the home page. Depending
on your geographical location, select "U.S. Product Documents" or "Int. Product
Documents". Follow the "Xfree Direct RT-PCR Documents" tab. Choose the appropriate
product number and follow the "Run Files" link to the platform of choice. Download the
Applied BiosystemsTM 7500 Fast Dx template. Alternatively, the Applied BiosystemsTM

7500 Fast Dx Real-Time PCR Instrument template can also be obtained by emailing
BioGX at info@biogx.com or eu@biogx.com. To manually program the thermocycler,
please refer to Appendix C. For further instrument information, please refer to the
Applied BiosystemsTM 7500 Fast Dx Real-Time PCR Instrument user manual10.

Bio-Rad CFX96 TouchTM Real-Time PCR Detection System
(Operating software: Maestro 1.1 or later)

Install the BioGX Protocol on the Bio-Rad CFX96 TouchTM Real-Time PCR Detection
System
It will be necessary to import the Bio-Rad CFX96 TouchTM Real-Time PCR Detection
System Protocol and Plate files. The most current versions of the Bio-Rad CFX96 TouchTM

Real-Time PCR Detection System Protocol and Plate files are available for download on
www.biogx.com. Follow the "Education Center" tab in the navigation menu at the top of
the home page. Depending on your location, select "U.S. Product Documents" or "Int.
Product Documents". Follow the "XfreeTM Direct RT-PCR Documents" tab. Choose the
appropriate product number and follow the "Run Files" link to the platform of choice.
Download the Bio-Rad CFX96 TouchTM Real-Time PCR Detection System Protocol and
Plate files. Alternatively, the Bio-Rad CFX96 TouchTM Real-Time PCR Detection System
Protocol and Plate files can also be obtained by emailing BioGX at info@biogx.com or
eu@biogx.com. To manually program the thermocycler, please refer to Appendix D. For
further instrument information, please refer to the Bio-Rad CFX96 TouchTM Real-Time
PCR Detection System user manual11.
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Bio-Rad CFX384 TouchTM Real-Time PCR Detection System
(Operating software: Maestro 1.1 or later)

Install the BioGX Protocol on the Bio-Rad CFX384 TouchTM Real-Time PCR Detection
System
It will be necessary to import the Bio-Rad CFX384 TouchTM Real-Time PCR Detection
System Protocol and Plate files. The most current versions of the Bio-Rad CFX384
TouchTM Real-Time PCR Detection System Protocol and Plate files are available for
download on www.biogx.com. Follow the "Education Center" tab in the navigation
menu at the top of the home page. Depending on your location, select "U.S. Product
Documents" or "Int. Product Documents". Follow the "XfreeTM Direct RT-PCR
Documents" tab. Choose the appropriate product number and follow the "Run Files" link
to the platform of choice. Download the Bio-Rad CFX384 TouchTM Real-Time PCR
Detection System Protocol and Plate files. Alternatively, the Bio-Rad CFX384 TouchTM

Real-Time PCR Detection System Protocol and Plate files can also be obtained by
emailing BioGX at info@biogx.com or eu@biogx.com. To manually program the
thermocycler, please refer to Appendix E. For further instrument information, please
refer to the Bio-Rad CFX384 TouchTM Real-Time PCR Detection System user manual11.

pixlTM Real-Time PCR Platform
(Operating software: version 1.6.9.0 or later)

Install the BioGX Protocol on the pixlTM Real-Time PCR Platform. It will be necessary to
import the pixlTM Real-Time PCR Platform template. The most current versions of the
pixlTM Real-Time PCR Platform template are available for download on www.biogx.com.
Follow the "Education Center" tab in the navigation menu at the top of the home page.
Depending on your location, select "U.S. Product Documents" or "Int. Product
Documents". Follow the "XfreeTM Direct RT-PCR Documents" tab. Choose the appropriate
product number and follow the "Run Files" link to the platform of choice. Download the
pixlTM Real-Time PCR Platform template. Alternatively, the pixlTM Real-Time PCR
Platform template can also be obtained by emailing BioGX at info@biogx.com or
eu@biogx.com. To manually program the thermocycler, please refer to Appendix F. For
further instrument information, please refer to the pixlTM Real-Time PCR Platform user
manual12.
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Bio Molecular Systems Mic Instrument
(Operating software: version 2.8 or later)

Install the BioGX Protocol on the Mic Instrument
It will be necessary to import the Mic Instrument template. The most current versions of
the Mic Instrument template are available for download on www.biogx.com. Follow the
"Education Center" tab in the navigation menu at the top of the home page. Depending
on your location, select "U.S. Product Documents" or "Int. Product Documents". Follow
the "XfreeTM Direct RT-PCR Documents" tab. Choose the appropriate product number
and follow the "Run Files" link to the platform of choice. Download the Mic Instrument.
Alternatively, the Mic Instrument template can also be obtained by emailing BioGX at
info@biogx.com or eu@biogx.com. To manually program the thermocycler, please refer
to Appendix G. For further instrument information, please refer to the Bio Molecular
Systems Mic Instrument user manual13.
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SPECIMEN PREPARATION

Direct Individual Patient Sample Addition
Pipette 5 μL of patient sample directly to tube/well containing RT-PCR master mix.

Validated sample types include nasopharyngeal, nasal, mid-turbinate, and
oropharyngeal swabs collected in 1 mL collection media or 3 mL collection media.
Additional validated sample types include nasopharyngeal wash/aspirates or nasal
aspirate collected in saline (0.85% NaCl).

Follow the “RT-PCR Set-up - Direct Patient Sample” section below for the appropriate
real-time PCR platform (i.e. Applied BiosystemsTM QuantStudioTM 5 Real-Time PCR
System (0.2 mL 96-well), Applied BiosystemsTM QuantStudioTM 5 Real-Time PCR System
(384-well), Applied BiosystemsTM 7500 Fast Dx Real-Time PCR Instrument, Bio-Rad CFX96
TouchTM Real-Time PCR Detection System, Bio-Rad CFX384 TouchTM Real-Time PCR
Detection System, Mic Instrument and pixlTM Real-Time PCR Platform).

Extracted Individual Patient Sample Addition
Pipette 5 μL of purified nucleic acid eluate directly into a tube/well containing RT-PCR
master mix.

Validated sample types extracted with Qiagen Viral RNA Mini Kit include
nasopharyngeal, nasal, mid-turbinate, and oropharyngeal swabs collected in 1 mL
collection media or 3 mL collection media.

Follow the “RT-PCR Set-up - Extracted Patient Sample” section below for the appropriate
real-time PCR platform (i.e. Applied BiosystemsTM QuantStudioTM 5 Real-Time PCR
System (0.2 mL 96-well), Applied BiosystemsTM QuantStudioTM 5 Real-Time PCR System
(384-well), Applied BiosystemsTM 7500 Fast Dx Real-Time PCR Instrument, Bio-Rad CFX96
TouchTM Real-Time PCR Detection System, Bio-Rad CFX384 TouchTM Real-Time PCR
Detection System, Mic Instrument and pixlTM Real-Time PCR Platform). For validated
magnetic bead or silica column nucleic acid extraction method, pipette appropriate
volume of specimen into the extraction tube/plate and proceed with protocol as per
manufacturer’s instructions for use. After extraction and elution, add 5 µL of the eluate
into a tube/well containing RT-PCR master mix.
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Pooled Direct Patient Sample Addition
Pipette 10 μL of pooled patient sample (equal volumes of up to 5 patient samples can be
pooled) directly to the tube/well containing RT-PCR master mix.

Validated sample types include nasopharyngeal, nasal, mid-turbinate, and
oropharyngeal swabs collected in 1 mL collection media or 3 mL collection media.
Additional validated sample types include nasopharyngeal wash/aspirates or nasal
aspirate collected in saline (0.85% NaCl).

Follow the “RT-PCR Set-up - Pooled Direct Patient Sample” section below for the
appropriate real-time PCR platform (i.e. Applied BiosystemsTM QuantStudioTM 5
Real-Time PCR System, Applied BiosystemsTM 7500 Fast Dx Real-Time PCR Instrument,
Bio-Rad CFX96 TouchTM Real-Time PCR Detection System and pixlTM Real-Time PCR
Platform.

Other Sample Types

This assay has been optimized for use with the specimen types and volumes
described above. Use of any other specimen type, collection method, or sample
volume may be inhibitory to the PCR. BioGX does not make claims for processing
methods or sample types other than those described in this manual.
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RT-PCR SET-UP - DIRECT PATIENT SAMPLE: Applied BiosystemsTM QuantStudioTM 5
Real-Time PCR System,
(0.2 mL 96-well)

1. Wear nitrile gloves when handling Sample-Ready lyophilized reagents to reduce
the generation of static charges. DO NOT use latex gloves.

2. Prepare the appropriate number of 8-tube PCR strips or 96-well PCR plates.
3. Using 1000 μL pipet tip, transfer 400 μL of molecular grade water to one vial of

lyophilized BioGX XfreeTM COVID-19 reagents. The rehydrated master mix is more
than sufficient for 26 samples to be tested by direct sample addition.

4. Mix by gently pipetting up and down with 1000 μL pipet tip. (IMPORTANT: Keep
rehydrated master mix in a cold block or on ice if set-up cannot be completed
within 20 minutes. If the rehydrated master mix is not fully dispensed, discard
unused volume).

5. Transfer 15 μL of rehydrated master mix to the bottom of 26 empty wells
(8-tube PCR strips or 96-well PCR plate).

6. To each well containing 15 μL of rehydrated master mix, add 5 μL of direct
patient sample.

7. Affix the instrument platform appropriate optical caps or optical plate seals.
8. Pulse spin the sealed 8-tube PCR strips or 96-well PCR plate to mix and bring

liquid to the bottom.
9. Load 8-tube PCR strips or 96-well PCR plates into the real-time PCR platform and

start run. Avoid unnecessary delay once tubes/plates are loaded.
10. Refer to Table 2 for result interpretation.

Note: For Applied BiosystemsTM QuantStudioTM 5 Real-Time PCR System template file for
Direct Patient Sample addition (500003XMPDirectQS5v2.edt), please refer to the
section: “Instrument Templates and Programming”: Install the BioGX Protocol on the
Applied BiosystemsTM QuantStudioTM 5 Real-Time PCR System for download
instructions. To manually program the thermocycler, please refer to Appendix A.
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RT-PCR SET-UP - DIRECT PATIENT SAMPLE: Applied BiosystemsTM QuantStudioTM 5
Real-Time PCR System (384-well)

1. Wear nitrile gloves when handling Sample-Ready lyophilized reagents to reduce
the generation of static charges. DO NOT use latex gloves.

2. Prepare the appropriate number of 384-well PCR plates.
3. Using 1000 μL pipet tip, transfer 400 μL of molecular grade water to one vial of

lyophilized BioGX XfreeTM COVID-19 reagents. The rehydrated master mix is more
than sufficient for 26 samples to be tested by direct sample addition.

4. Mix by gently pipetting up and down with 1000 μL pipet tip. (IMPORTANT: Keep
rehydrated master mix in a cold block or on ice if set-up cannot be completed
within 20 minutes. If the rehydrated master mix is not fully dispensed, discard
unused volume).

5. Transfer 15 μL of rehydrated master mix to the bottom of 26 empty wells
(384-well PCR plate).

6. To each well containing 15 μL of rehydrated master mix, add 5 μL of direct
patient sample.

7. Affix the instrument platform appropriate optical caps or optical plate seals.
8. Pulse spin the sealed PCR plate to mix and bring liquid to the bottom.
9. Load 384-well PCR plates into the real-time PCR platform and start run. Avoid

unnecessary delay once tubes/plates are loaded.
10. Refer to Table 2 for result interpretation.

Note: For Applied BiosystemsTM QuantStudioTM 5 Real-Time PCR System, 384-well
template file for Direct Patient Sample addition (500003XMPDirectQS5_384Rev01.edt),
please refer to the section: “Instrument Templates and Programming”: Install the
BioGX Protocol on the Applied BiosystemsTM QuantStudioTM 5 Real-Time PCR System
(384-well) for download instructions. To manually program the thermocycler, please
refer to Appendix B.
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RT-PCR SET-UP - DIRECT PATIENT SAMPLE: Applied BiosystemsTM 7500 Fast Dx
Real-Time PCR Instrument

1. Wear nitrile gloves when handling Sample-Ready lyophilized reagents to reduce
the generation of static charges. DO NOT use latex gloves.

2. Prepare the appropriate number of 8-tube PCR strips or 96-well PCR plates.
3. Using 1000 μL pipet tip, transfer 400 μL of molecular grade water to one vial of

lyophilized BioGX XfreeTM COVID-19 reagents. The rehydrated master mix is more
than sufficient for 26 samples to be tested by direct sample addition.

4. Mix by gently pipetting up and down with 1000 μL pipet tip. (IMPORTANT: Keep
rehydrated master mix in a cold block or on ice if set-up cannot be completed
within 20 minutes. If the rehydrated master mix is not fully dispensed, discard
unused volume).

5. Transfer 15 μL of rehydrated master mix to the bottom of 26 empty wells
(8-tube PCR strips or 96-well PCR plate).

6. To each well containing 15 μL of rehydrated master mix, add 5 μL of direct
patient sample.

7. Affix the instrument platform appropriate optical caps or optical plate seals.
8. Pulse spin the sealed 8-tube PCR strips or 96-well PCR plate to mix and bring

liquid to the bottom.
9. Load 8-tube PCR strips or 96-well PCR plates into the real-time PCR platform and

start run. Avoid unnecessary delay once tubes/plates are loaded.
10. Refer to Table 2 for result interpretation.

Note: For Applied BiosystemsTM 7500 Fast Dx Real-Time PCR Instrument template file for
Direct Patient Sample addition (500003XMPDirect7500Dx.sdt), please refer to the
section: “Instrument Templates and Programming”: Install the BioGX Protocol on the
Applied BiosystemsTM 7500 Fast Dx Real-Time PCR Instrument for download
instructions. To manually program the thermocycler, please refer to Appendix C.
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RT-PCR SET-UP - DIRECT PATIENT SAMPLE: Bio-Rad CFX96 TouchTM Real-Time PCR
Detection System

1. Wear nitrile gloves when handling Sample-Ready lyophilized reagents to reduce
the generation of static charges. DO NOT use latex gloves.

2. Prepare the appropriate number of 8-tube PCR strips or 96-well PCR plates.
3. Using 1000 μL pipet tip, transfer 400 μL of molecular grade water to one vial of

lyophilized BioGX XfreeTM COVID-19 reagents. The rehydrated master mix is more
than sufficient for 26 samples to be tested by direct sample addition.

4. Mix by gently pipetting up and down with 1000 μL pipet tip. (IMPORTANT: Keep
rehydrated master mix in a cold block or on ice if set-up cannot be completed
within 20 minutes. If the rehydrated master mix is not fully dispensed, discard
unused volume).

5. Transfer 15 μL of rehydrated master mix to the bottom of 26 empty wells
(8-tube PCR strips or 96-well PCR plate).

6. To each well containing 15 μL of rehydrated master mix, add 5 μL of direct
patient sample.

7. Affix the appropriate optical caps or optical plate seals.
8. Pulse spin the sealed 8-tube PCR strips or 96-well PCR plates to mix and bring

liquid to the bottom.
9. When the CFX96 TouchTM run is completed, the threshold setting update will

need to be completed as follows:
a. Open the “Data Analysis” window for your specific run
b. To apply threshold settings for FAM-channel, uncheck CalRed 610-channel

and Quasar 670-channel and be sure “FAM” is checked (Note: Threshold
adjustments can be performed only in single threshold mode, be sure
only one dye is selected)
i. Navigate to “Settings” and select “Baseline Threshold”
ii. At the bottom of the popup window under “single threshold”, select

“User Defined” and enter “500”
iii. Click “OK” and the threshold for FAM will apply to the experiment.

c. To apply threshold settings for CalRed 610-channel, uncheck FAM-channel
and Quasar 670-channel and be sure “CalRed 610” is checked (Note:
Threshold adjustments can be performed only in single threshold mode,
be sure only one dye is selected)
i. Navigate to “Settings” and select “Baseline Threshold”
ii. At the bottom of the popup window under “single threshold”, select

“User Defined” and enter “500”
iii. Click “OK” and the threshold for CalRed 610 will apply to the

experiment
d. To apply threshold settings for Quasar 670-channel, uncheck

FAM-channel and CalRed 610-channel and be sure “Quasar 670” is
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checked (Note: Threshold adjustments can be performed only in single
threshold mode, be sure only one dye is selected)
i. Navigate to “Settings” and select “Baseline Threshold”
ii. At the bottom of the popup window under “single threshold”, select

“User Defined” and enter “500”
iii. Click “OK” and the threshold for Quasar 670 will apply to the

experiment
10. Refer to Table 2 for result interpretation.

Note: For Bio-Rad CFX96 TouchTM Real-Time PCR Detection System protocol and plate
files for Direct Patient Sample addition (500003XMPDirectCFX96v2.prcl and
500003XMPDirect_plateCFX96v2.pltd), please refer to the section: “Instrument
Templates and Programming”: Install the BioGX Protocol on the Bio-Rad CFX96
TouchTM Real-Time PCR Detection System for download instructions. To manually
program the thermocycler, please refer to Appendix D.
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RT-PCR SET-UP - DIRECT PATIENT SAMPLE: Bio-Rad CFX384 TouchTM Real-Time PCR
Detection System

1. Wear nitrile gloves when handling Sample-Ready lyophilized reagents to reduce
the generation of static charges. DO NOT use latex gloves.

2. Prepare the appropriate number of 384-well PCR plates.
3. Using 1000 μL pipet tip, transfer 400 μL of molecular grade water to one vial of

lyophilized BioGX XfreeTM COVID-19 reagents. The rehydrated master mix is more
than sufficient for 26 samples to be tested by direct sample addition.

4. Mix by gently pipetting up and down with 1000 μL pipet tip. (IMPORTANT: Keep
rehydrated master mix in a cold block or on ice if set-up cannot be completed
within 20 minutes. If the rehydrated master mix is not fully dispensed, discard
unused volume).

5. Transfer 15 μL of rehydrated master mix to the bottom of 26 empty wells
(384-well PCR plate).

6. To each well containing 15 μL of rehydrated master mix, add 5 μL of direct
patient sample.

7. Affix the appropriate optical caps or optical plate seals.
8. Pulse spin the sealed 384-well PCR plate to mix and bring liquid to the bottom.
9. When CFX384 TouchTM run is completed, threshold setting update will need to be

completed as follows:
a. Open the “Data Analysis” window for your specific run
b. To apply threshold settings for FAM-channel, uncheck CalRed 610-channel

and Quasar 670-channel and be sure “FAM” is checked (Note: Threshold
adjustments can be performed only in single threshold mode, be sure
only one dye is selected)
i. Navigate to “Settings” and select “Baseline Threshold”
ii. At the bottom of the popup window under “single threshold”, select

“User Defined” and enter “500”
iii. Click “OK” and the threshold for FAM will apply to the experiment.

d. To apply threshold settings for CalRed 610-channel, uncheck FAM-channel
and Quasar 670-channel and be sure “CalRed 610” is checked (Note:
Threshold adjustments can be performed only in single threshold mode,
be sure only one dye is selected)
i. Navigate to “Settings” and select “Baseline Threshold”
ii. At the bottom of the popup window under “single threshold”, select

“User Defined” and enter “250”
iii. Click “OK” and the threshold for CalRed 610 will apply to the

experiment
e. To apply threshold settings for Quasar 670-channel, uncheck

FAM-channel and CalRed 610-channel and be sure “Quasar 670” is
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checked (Note: Threshold adjustments can be performed only in single
threshold mode, be sure only one dye is selected)
i. Navigate to “Settings” and select “Baseline Threshold”
ii. At the bottom of the popup window under “single threshold”, select

“User Defined” and enter “500”
iii. Click “OK” and the threshold for Quasar 670 will apply to the

experiment
10. Refer to Table 2 for result interpretation.

Note: For Bio-Rad CFX384 TouchTM Real-Time PCR Detection System protocol and plate
files for Direct Patient Sample addition (500003XMPDirectCFX384.prcl and
500003XMPDirect_plateCFX384.pltd), please refer to the section: “Instrument
Templates and Programming”: Install the BioGX Protocol on the Bio-Rad CFX384
TouchTM Real-Time PCR Detection System for download instructions. To manually
program the thermocycler, please refer to Appendix E.
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RT-PCR SET-UP - DIRECT PATIENT SAMPLE: pixlTM Real-Time PCR Platform

1. Wear nitrile gloves when handling Sample-Ready lyophilized reagents to reduce
the generation of static charges. DO NOT use latex gloves.

2. Prepare the appropriate number of 8-tube PCR strips.
3. Using 1000 μL pipet tip, transfer 400 μL of molecular grade water to one vial of

lyophilized BioGX XfreeTM COVID-19 reagents. The rehydrated master mix is more
than sufficient for 26 samples to be tested by direct sample addition.

4. Mix by gently pipetting up and down with 1000 μL pipet tip. (IMPORTANT: Keep
rehydrated master mix in a cold block or on ice if set-up cannot be completed
within 20 minutes. If the rehydrated master mix is not fully dispensed, discard
unused volume).

5. Transfer 15 μL of rehydrated master mix to the bottom of 1 to 16 empty PCR
tubes (8-tube PCR strips).

6. To each PCR tube containing 15 μL of rehydrated master mix, add 5 μL of direct
patient sample.

7. Affix the optical caps.
8. Pulse spin the sealed 8-tube PCR strips to mix and bring liquid to the bottom.
9. Load 8-tube PCR strips into the real-time PCR platform and start run. Avoid

unnecessary delay once tubes are loaded.
10. Refer to Table 2 for result interpretation.

Note: For pixlTM Real-Time PCR Platform template file for Direct Patient Sample addition
(500003XMPDirExtpixlRev01.json), please refer to the section: “Instrument Templates
and Programming”: Install the BioGX Protocol on the pixlTM Real-Time PCR Platform
for download instructions. To manually program the thermocycler, please refer to
Appendix F.
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RT-PCR SET-UP - DIRECT PATIENT SAMPLE: Bio Molecular Systems Mic Instrument

1. Wear nitrile gloves when handling Sample-Ready lyophilized reagents to reduce
the generation of static charges. DO NOT use latex gloves.

2. Prepare the appropriate number of PCR tubes.
3. Using 1000 μL pipet tip, transfer 400 μL of molecular grade water to one vial of

lyophilized BioGX XfreeTM COVID-19 reagents. The rehydrated master mix is more
than sufficient for 26 samples to be tested by direct sample addition.

4. Mix by gently pipetting up and down with 1000 μL pipet tip. (IMPORTANT: Keep
rehydrated master mix in a cold block or on ice if set-up cannot be completed
within 20 minutes. If the rehydrated master mix is not fully dispensed, discard
unused volume).

5. Transfer 15 μL of rehydrated master mix to the bottom of 26 empty PCR tubes.
To each PCR tube containing 15 μL of rehydrated master mix, add 5 μL of direct
patient sample.

6. Affix the reaction tube caps.
7. Pulse spin the sealed PCR tubes to mix and bring liquid to the bottom.
8. Load the reaction tubes into the real-time PCR platform and start run. Avoid

unnecessary delay once tubes are loaded.
9. Refer to Table 2 for result interpretation.

Note: For Bio Molecular Systems Mic Instrument template file for Direct Patient Sample
addition (500003XMPDirectMIC.mictemplate), please refer to the section: “Instrument
Templates and Programming”: Install the BioGX Protocol on the Bio Molecular Systems
Mic Instrument for download instructions. To manually program the thermocycler,
please refer to Appendix G.

Page 31 of 121 500-003-XMP (CE-IVD) Rev. 09-07APR2023



COVID-19 Direct RT-PCR
Extraction-Free Multiplatform

RT-PCR SET-UP - EXTRACTED PATIENT SAMPLE: Applied BiosystemsTM QuantStudioTM 5
Real-Time PCR System (0.2 mL 96-well)

1. Wear nitrile gloves when handling Sample-Ready lyophilized reagents to reduce
the generation of static charges. DO NOT use latex gloves.

2. Prepare the appropriate number of 8-tube PCR strips or 96-well PCR plates.
3. Using 1000 μL pipet tip, transfer 400 μL of molecular grade water to one vial of

lyophilized BioGX XfreeTM COVID-19 reagents. The rehydrated master mix is
sufficient for 40 samples to be tested using purified nucleic acid samples.

4. Mix by gently pipetting up and down with 1000 μL pipet tip. (IMPORTANT: Keep
rehydrated master mix in a cold block or on ice if set-up cannot be completed
within 20 minutes. If the rehydrated master mix is not fully dispensed, discard
unused volume).

5. Transfer 10 μL of rehydrated master mix to the bottom of 40 empty wells
(8-tube PCR strips or 96-well PCR plate).

6. To each well containing 10 μL of rehydrated master mix, add 5 μL of extracted
patient sample.

7. Affix the appropriate optical caps or optical plate seals.
8. Pulse spin the sealed 8-tube PCR strips or 96-well PCR plate to mix and bring

liquid to the bottom.
9. Load 8-tube PCR strips or 96-well PCR plates into the real-time PCR platform and

start run. Avoid unnecessary delay once tubes/plates are loaded.
10. Refer to Table 2 for result interpretation.

Note: For Applied BiosystemsTM QuantStudioTM 5 Real-Time PCR System template file for
Extracted Patient Sample addition (500003XMPExtractQS5v2.edt), please refer to the
section: “Instrument Templates and Programming”: Install the BioGX Protocol on the
Applied BiosystemsTM QuantStudioTM 5 Real-Time PCR System for download
instructions. To manually program the thermocycler, please refer to Appendix A.
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RT-PCR SET-UP - EXTRACTED PATIENT SAMPLE: Applied BiosystemsTM QuantStudioTM 5
Real-Time PCR System (384-well)

1. Wear nitrile gloves when handling Sample-Ready lyophilized reagents to reduce
the generation of static charges. DO NOT use latex gloves.

2. Prepare the appropriate number of 384-well PCR plates.
3. Using 1000 μL pipet tip, transfer 400 μL of molecular grade water to one vial of

lyophilized BioGX XfreeTM COVID-19 reagents. The rehydrated master mix is
sufficient for 40 samples to be tested using purified nucleic acid samples.

4. Mix by gently pipetting up and down with 1000 μL pipet tip. (IMPORTANT: Keep
rehydrated master mix in a cold block or on ice if set-up cannot be completed
within 20 minutes. If the rehydrated master mix is not fully dispensed, discard
unused volume).

5. Transfer 10 μL of rehydrated master mix to the bottom of 40 empty wells
(384-well PCR plate).

6. To each well containing 10 μL of rehydrated master mix, add 5 μL of extracted
patient sample.

7. Affix the appropriate optical plate seals.
8. Pulse spin the sealed 384-well PCR plates to mix and bring liquid to the bottom.
9. Load 384-well PCR plates into the real-time PCR platform and start run. Avoid

unnecessary delay once plates are loaded.
10. Refer to Table 2 for result interpretation.

Note: For Applied BiosystemsTM QuantStudioTM 5 Real-Time PCR System, 384-well
template file for Extracted Patient Sample addition
(500003XMPExtractedQS5_384Rev01.edt), please refer to the section: “Instrument
Templates and Programming”: Install the BioGX Protocol on the Applied BiosystemsTM

QuantStudioTM 5 Real-Time PCR System, 384-well for download instructions. To
manually program the thermocycler, please refer to Appendix B.
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RT-PCR SET-UP - EXTRACTED PATIENT SAMPLE: Applied BiosystemsTM 7500 Fast Dx
Real-Time PCR Instrument

1. Wear nitrile gloves when handling Sample-Ready lyophilized reagents to reduce
the generation of static charges. DO NOT use latex gloves.

2. Prepare the appropriate number of 8-tube PCR strips or 96-well PCR plates.
3. Using 1000 μL pipet tip, transfer 400 μL of molecular grade water to one vial of

lyophilized BioGX XfreeTM COVID-19 reagents. The rehydrated master mix is more
than sufficient for 40 samples to be tested using purified nucleic acid samples.

4. Mix by gently pipetting up and down with 1000 μL pipet tip. (IMPORTANT: Keep
rehydrated master mix in a cold block or on ice if set-up cannot be completed
within 20 minutes. If the rehydrated master mix is not fully dispensed, discard
unused volume).

5. Transfer 10 μL of rehydrated master mix to the bottom of 40 empty wells
(8-tube PCR strips or 96-well PCR plate).

6. To each well containing 10 μL of rehydrated master mix, add 5 μL of extracted
patient sample.

7. Affix the appropriate optical caps or optical plate seals.
8. Pulse spin the sealed 8-tube PCR strips or 96-well PCR plates to mix and bring

liquid to the bottom.
9. Load 8-tube PCR strips or 96-well PCR plates into the real-time PCR platform and

start run. Avoid unnecessary delay once tubes/plates are loaded.
10. Refer to Table 2 for result interpretation.

Note: For Applied BiosystemsTM 7500 Fast Dx Real-Time PCR Instrument template file for
Extracted Patient Sample addition (500003XMPExtract7500Dx.sdt), please refer to the
section: “Instrument Templates and Programming”: Install the BioGX Protocol on the
Applied BiosystemsTM 7500 Fast Dx Real-Time PCR Instrument for download
instructions. To manually program the thermocycler, please refer to Appendix C.
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RT-PCR SET-UP - EXTRACTED PATIENT SAMPLE: Bio-Rad CFX96 TouchTM Real-Time PCR
Detection System

1. Wear nitrile gloves when handling Sample-Ready lyophilized reagents to reduce
the generation of static charges. DO NOT use latex gloves.

2. Prepare the appropriate number of 8-tube PCR strips or 96-well PCR plates.
3. Using 1000 μL pipet tip, transfer 400 μL of molecular grade water to one vial of

lyophilized BioGX XfreeTM COVID-19 reagents. The rehydrated master mix is more
than sufficient for 40 samples to be tested using purified nucleic acid samples.

4. Mix by gently pipetting up and down with 1000 μL pipet tip. (IMPORTANT: Keep
rehydrated master mix in a cold block or on ice if set-up cannot be completed
within 20 minutes. If the rehydrated master mix is not fully dispensed, discard
unused volume).

5. Transfer 10 μL of rehydrated master mix to the bottom of 40 empty wells (8-tube
PCR strips or 96-well PCR plate).

6. To each well containing 10 μL of rehydrated master mix, add 5 μL of extracted
patient sample.

7. Affix the appropriate optical caps or optical plate seals.
8. Pulse spin the sealed PCR plate or tube to mix and bring liquid to the bottom.
9. When CFX96 Touch run is completed, threshold setting update will need to be

completed as follows:
a. Open the “Data Analysis” window for your specific run
b. To apply threshold settings for FAM-channel, uncheck CalRed 610-channel

and Quasar 670-channel and be sure “FAM” is checked (Note: Threshold
adjustments can be performed only in single threshold mode, be sure only
one dye is selected)
i. Navigate to “Settings” and select “Baseline Threshold”
ii. At the bottom of the popup window under “single threshold”, select

“User Defined” and enter “500”
iii. Click “OK” and the threshold for FAM will apply to the experiment.

c. To apply threshold settings for CalRed 610-channel, uncheck FAM-channel
and Quasar 670-channel and be sure “CalRed 610” is checked (Note:
Threshold adjustments can be performed only in single threshold mode,
be sure only one dye is selected)
i. Navigate to “Settings” and select “Baseline Threshold”
ii. At the bottom of the popup window under “single threshold”, select

“User Defined” and enter “500”
iii. Click “OK” and the threshold for CalRed 610 will apply to the

experiment
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d. To apply threshold settings for Quasar 670-channel, uncheck FAM-channel
and CalRed 610-channel and be sure “Quasar 670” is checked (Note:
Threshold adjustments can be performed only in single threshold mode,
be sure only one dye is selected)
i. Navigate to “Settings” and select “Baseline Threshold”
ii. At the bottom of the popup window under “single threshold”, select

“User Defined” and enter “500”
iii. Click “OK” and the threshold for Quasar 670 will apply to the

experiment
10. Refer to Table 2 for result interpretation.

Note: For Bio-Rad CFX96 TouchTM Real-Time PCR Detection System protocol and plate
files for Extracted Patient Sample addition (500003XMPExtractCFX96v2.prcl and
500003XMPExtract_plateCFX96v2.pltd), please refer to the section: “Instrument
Templates and Programming”: Install the BioGX Protocol on the Bio-Rad CFX96 TouchTM

Real-Time PCR Detection System for download instructions. To manually program the
thermocycler, please refer to Appendix D.
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RT-PCR SET-UP - EXTRACTED PATIENT SAMPLE: Bio-Rad CFX384 TouchTM Real-Time PCR
Detection System

1. Wear nitrile gloves when handling Sample-Ready lyophilized reagents to reduce
the generation of static charges. DO NOT use latex gloves.

2. Prepare the appropriate number of 384-well PCR plates.
3. Using 1000 μL pipet tip, transfer 400 μL of molecular grade water to one vial of

lyophilized BioGX XfreeTM COVID-19 reagents. The rehydrated master mix is more
than sufficient for 40 samples to be tested using purified nucleic acid samples.

4. Mix by gently pipetting up and down with 1000 μL pipet tip. (IMPORTANT: Keep
rehydrated master mix in a cold block or on ice if set-up cannot be completed
within 20 minutes. If the rehydrated master mix is not fully dispensed, discard
unused volume).

5. Transfer 10 μL of rehydrated master mix to the bottom of 40 empty wells
(384-well PCR plate).

6. To each well containing 10 μL of rehydrated master mix, add 5 μL of extracted
patient sample.

7. Affix the appropriate optical plate seals.
8. Pulse spin the sealed 384-well PCR plate to mix and bring liquid to the bottom.
9. When CFX384 TouchTM run is completed, threshold setting update will need to be

completed as follows:
a. Open the “Data Analysis” window for your specific run
b. To apply threshold settings for FAM-channel, uncheck CalRed 610-channel

and Quasar 670-channel and be sure “FAM” is checked (Note: Threshold
adjustments can be performed only in single threshold mode, be sure
only one dye is selected)
i. Navigate to “Settings” and select “Baseline Threshold”
ii. At the bottom of the popup window under “single threshold”, select

“User Defined” and enter “500”
iii. Click “OK” and the threshold for FAM will apply to the experiment.

c. To apply threshold settings for CalRed 610-channel, uncheck FAM-channel
and Quasar 670-channel and be sure “CalRed 610” is checked (Note:
Threshold adjustments can be performed only in single threshold mode,
be sure only one dye is selected)
i. Navigate to “Settings” and select “Baseline Threshold”
ii. At the bottom of the popup window under “single threshold”, select

“User Defined” and enter “250”
iii. Click “OK” and the threshold for CalRed 610 will apply to the

experiment
d. To apply threshold settings for Quasar 670-channel, uncheck

FAM-channel and CalRed 610-channel and be sure “Quasar 670” is
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checked (Note: Threshold adjustments can be performed only in single
threshold mode, be sure only one dye is selected)
i. Navigate to “Settings” and select “Baseline Threshold”
ii. At the bottom of the popup window under “single threshold”, select

“User Defined” and enter “500”
iii. Click “OK” and the threshold for Quasar 670 will apply to the

experiment
10. Refer to Table 2 for result interpretation.

Note: For Bio-Rad CFX384 TouchTM Real-Time PCR Detection System protocol and plate
files for Extracted Patient Sample addition (500003XMPExtractCFX384.prcl and
500003XMPExtract_plateCFX384.pltd), please refer to the section: “Instrument
Templates and Programming”: Install the BioGX Protocol on the Bio-Rad CFX96
TouchTM Real-Time PCR Detection System for download instructions. To manually
program the thermocycler, please refer to Appendix E.
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RT-PCR SET-UP - EXTRACTED PATIENT SAMPLE: pixlTM Real-Time PCR Platform

1. Wear nitrile gloves when handling Sample-Ready lyophilized reagents to reduce
the generation of static charges. DO NOT use latex gloves.

2. Prepare the appropriate number of 8-tube PCR strips.
3. Using 1000 μL pipet tip, transfer 400 μL of molecular grade water to one vial of

lyophilized BioGX XfreeTM COVID-19 reagents. The rehydrated master mix is
sufficient for 40 samples to be tested using purified nucleic acid samples.

4. Mix by gently pipetting up and down with 1000 μL pipet tip. (IMPORTANT: Keep
rehydrated master mix in a cold block or on ice if set-up cannot be completed
within 20 minutes. If the rehydrated master mix is not fully dispensed, discard
unused volume).

5. Transfer 10 μL of rehydrated master mix to the bottom of 1 to 16 empty wells
(8-tube PCR strips).

6. To each well containing 10 μL of rehydrated master mix, add 5 μL of extracted
patient sample.

7. Affix the optical caps.
8. Pulse spin the sealed tubes to mix and bring liquid to the bottom.
9. Load 8-tube PCR strips into the real-time PCR platform and start run. Avoid

unnecessary delay once tubes are loaded.
10. Refer to Table 2 for result interpretation.

Note: For pixlTM Real-Time PCR Platform template file for Extracted Patient Sample
addition (500003XMPDirExtpixlRev01.json), please refer to the section: “Instrument
Templates and Programming”: Install the BioGX Protocol on the pixlTM Real-Time PCR
Platform for download instructions. To manually program the thermocycler, refer to
Appendix F.
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RT-PCR SET-UP - EXTRACTED PATIENT SAMPLE: Bio Molecular Systems Mic Instrument

1. Wear nitrile gloves when handling Sample-Ready lyophilized reagents to reduce
the generation of static charges. DO NOT use latex gloves.

2. Prepare the appropriate number of PCR tubes.
3. Using 1000 μL pipet tip, transfer 400 μL of molecular grade water to one vial of

lyophilized BioGX XfreeTM COVID-19 reagents. The rehydrated master mix is more
than sufficient for 26 samples to be tested by direct sample addition.

4. Mix by gently pipetting up and down with 1000 μL pipet tip. (IMPORTANT: Keep
rehydrated master mix in a cold block or on ice if set-up cannot be completed
within 20 minutes. If the rehydrated master mix is not fully dispensed, discard
unused volume).

5. Transfer 10 μL of rehydrated master mix to the bottom of 40 empty wells (PCR
tubes).

6. To each well containing 10 μL of rehydrated master mix, add 5 μL of extracted
patient sample.

7. Affix the reaction tube caps.
8. Pulse spin the sealed PCR tubes to mix and bring liquid to the bottom.
9. Load the reaction tubes into the real-time PCR platform and start run. Avoid

unnecessary delay once tubes are loaded.
10. Refer to Table 2 for result interpretation.

Note: For Bio Molecular Systems Mic Instrument template file for extracted Patient
Sample addition (500003XMPExtractedMIC.mictemplate), please refer to the section:
“Instrument Templates and Programming”: Install the BioGX Protocol on the Bio
Molecular Systems Mic Instrument for download instructions. To manually program the
thermocycler, please refer to Appendix G.
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RT-PCR SET-UP - POOLED DIRECT PATIENT SAMPLE: Applied BiosystemsTM

QuantStudioTM 5 Real-Time PCR System (0.2 mL 96-well)

1. Wear nitrile gloves when handling Sample-Ready lyophilized reagents to reduce
the generation of static charges. DO NOT use latex gloves.

2. Prepare the appropriate number of 8-tube PCR strips or 96-well PCR plates.
3. Using 1000 μL pipet tip, transfer 400 μL of molecular grade water to one vial of

lyophilized BioGX XfreeTM COVID-19 reagents. The rehydrated master mix is more
than sufficient for 13 pooled samples (each pooled sample consisting of 5
individual patient samples) to be tested by direct sample addition.

4. Mix by gently pipetting up and down with 1000 μL pipet tip. (IMPORTANT: Keep
rehydrated master mix in a cold block or on ice if set-up cannot be completed
within 20 minutes. If the rehydrated master mix is not fully dispensed, discard
unused volume).

5. Transfer 30 μL of rehydrated master mix to the bottom of 13 empty wells
(8-tube PCR strips or 96-well PCR plate).

6. Prepare one pool of 5 patient samples by transferring an equal volume
(minimum of 50 μL) of each patient sample into an empty sterile tube. Mix by
gently pipetting up and down.

7. To each well containing 30 μL of rehydrated master mix, add 10 μL of pooled
direct patient sample.

8. Affix the appropriate optical caps or optical plate seals.
9. Pulse spin the sealed 8-tube PCR strips or 96-well PCR plates to mix and bring

liquid to the bottom.
10. Load 8-tube PCR strips or 96-well PCR plates into the real-time PCR platform and

start run. Avoid unnecessary delay once tubes/plates are loaded.
11. Refer to Table 2 for result interpretation.

Note: For Applied BiosystemsTM QuantStudioTM 5 Real-Time PCR System template file for
Pooled Direct Patient Sample addition (500003XMPDirectPooledQS5Rev01.edt), please
refer to the section: “Instrument Templates and Programming”: Install the BioGX
Protocol on the Applied BiosystemsTM QuantStudioTM 5 Real-Time PCR System for
download instructions. To manually program the thermocycler, please refer to Appendix
A.
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RT-PCR SET-UP - POOLED DIRECT PATIENT SAMPLE: Applied BiosystemsTM 7500 Fast Dx
Real-Time PCR Instrument

1. Wear nitrile gloves when handling Sample-Ready lyophilized reagents to reduce
the generation of static charges. DO NOT use latex gloves.

2. Prepare the appropriate number of 8-tube PCR strips or 96-well PCR plates.
3. Using 1000 μL pipet tip, transfer 400 μL of molecular grade water to one vial of

lyophilized BioGX XfreeTM COVID-19 reagents. The rehydrated master mix is more
than sufficient for 26 samples to be tested by direct sample addition.

4. Mix by gently pipetting up and down with 1000 μL pipet tip. (IMPORTANT: Keep
rehydrated master mix in a cold block or on ice if set-up cannot be completed
within 20 minutes. If the rehydrated master mix is not fully dispensed, discard
unused volume).

5. Transfer 30 μL of rehydrated master mix to the bottom of 13 empty wells
(8-tube PCR strips or 96-well PCR plate).

6. Prepare one pool of 5 patient samples by transferring an equal volume
(minimum of 50 μL) of each patient sample into an empty sterile tube. Mix by
gently pipetting up and down.

7. To each well containing 30 μL of rehydrated master mix, add 10 μL of pooled
direct patient sample.

8. Affix the instrument platform appropriate optical caps or optical plate seals.
9. Pulse spin the sealed 8-tube PCR strips or 96-well PCR plate to mix and bring

liquid to the bottom.
10. Load 8-tube PCR strips or 96-well PCR plates into the real-time PCR platform and

start run. Avoid unnecessary delay once tubes/plates are loaded.
11. Refer to Table 2 for result interpretation.

Note: For Applied BiosystemsTM 7500 Fast Dx Real-Time PCR Instrument template file for
Pooled Direct Patient Sample addition (500003XMPDirectPooled7500DxRev01.sdt),
please refer to the section: “Instrument Templates and Programming”: Install the
BioGX Protocol on the Applied BiosystemsTM 7500 Fast Dx Real-Time PCR Instrument
for download instructions. To manually program the thermocycler, please refer to
Appendix C.
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RT-PCR SET-UP - POOLED DIRECT PATIENT SAMPLE: Bio-Rad CFX96 TouchTM Real-Time
PCR Detection System

1. Wear nitrile gloves when handling Sample-Ready lyophilized reagents to reduce
the generation of static charges. DO NOT use latex gloves.

2. Prepare the appropriate number of 8-tube PCR strips or 96-well PCR plates.
3. Using 1000 μL pipet tip, transfer 400 μL of molecular grade water to one vial of

lyophilized BioGX XfreeTM COVID-19 reagents. The rehydrated master mix is more
than sufficient for 13 pooled samples (each pooled sample consisting of 5
individual patient samples) to be tested by direct sample addition.

4. Mix by gently pipetting up and down with 1000 μL pipet tip. (IMPORTANT: Keep
rehydrated master mix in a cold block or on ice if set-up cannot be completed
within 20 minutes. If the rehydrated master mix is not fully dispensed, discard
unused volume).

5. Transfer 30 μL of rehydrated master mix to the bottom of 13 empty wells
(8-tube PCR strips or 96-well PCR plate).

6. Prepare a pool of 5 patient samples by transferring an equal volume (minimum
of 50 μL) of each patient sample into an empty sterile tube. Mix by gently
pipetting up and down.

7. To each well containing 30 μL of rehydrated master mix, add 10 μL of the pooled
direct patient sample.

8. Affix the appropriate optical caps or optical plate seals.
9. Pulse spin the sealed 8-tube PCR strips or 96-well PCR plates to mix and bring

liquid to the bottom.
10. When CFX96 TouchTM run is completed, threshold setting update will need to be

completed as follows:
a. Open the “Data Analysis” window for your specific run
b. To apply threshold settings for FAM-channel, uncheck CalRed 610-channel

and Quasar 670-channel and be sure “FAM” is checked (Note: Threshold
adjustments can be performed only in single threshold mode, be sure
only one dye is selected)
i. Navigate to “Settings” and select “Baseline Threshold”
ii. At the bottom of the popup window under “single threshold”, select

“User Defined” and enter “500”
iii. Click “OK” and the threshold for FAM will apply to the experiment.

c. To apply threshold settings for CalRed 610-channel, uncheck FAM-channel
and Quasar 670-channel and be sure “CalRed 610” is checked (Note:
Threshold adjustments can be performed only in single threshold mode,
be sure only one dye is selected)
i. Navigate to “Settings” and select “Baseline Threshold”
ii. At the bottom of the popup window under “single threshold”, select

“User Defined” and enter “500”
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iii. Click “OK” and the threshold for CalRed 610 will apply to the
experiment

d. To apply threshold settings for Quasar 670-channel, uncheck
FAM-channel and CalRed 610-channel and be sure “Quasar 670” is
checked (Note: Threshold adjustments can be performed only in single
threshold mode, be sure only one dye is selected)
i. Navigate to “Settings” and select “Baseline Threshold”
ii. At the bottom of the popup window under “single threshold”, select

“User Defined” and enter “500”
iii. Click “OK” and the threshold for Quasar 670 will apply to the

experiment
11. Refer to Table 2 for result interpretation.

Note: For Bio-Rad CFX96 TouchTM Real-Time PCR Detection System protocol and plate
files for Pooled Direct Patient Sample addition
(500003XMPDirectPooledCFX96Rev01.prcl and
500003XMPDirectPooledCFX96PlateRev01.pltd), please refer to the section:
“Instrument Templates and Programming”: Install the BioGX Protocol on the Bio-Rad
CFX96 TouchTM Real-Time PCR Detection System for download instructions. To manually
program the thermocycler, please refer to Appendix D.
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RT-PCR SET-UP - POOLED DIRECT PATIENT SAMPLE: pixlTM Real-Time PCR Platform

1. Wear nitrile gloves when handling Sample-Ready lyophilized reagents to reduce
the generation of static charges. DO NOT use latex gloves.

2. Prepare the appropriate number of 8-tube PCR strips.
3. Using 1000 μL pipet tip, transfer 400 μL of molecular grade water to one vial of

lyophilized BioGX XfreeTM COVID-19 reagents. The rehydrated master mix is more
than sufficient for 13 pooled samples (each pooled sample consisting of 5
individual patient samples) to be tested by direct sample addition.

4. Mix by gently pipetting up and down with 1000 μL pipet tip. (IMPORTANT: Keep
rehydrated master mix in a cold block or on ice if set-up cannot be completed
within 20 minutes. If the rehydrated master mix is not fully dispensed, discard
unused volume).

5. Transfer 30 μL of rehydrated master mix to the bottom of 13 empty wells
(8-tube PCR strips).

6. Prepare one pool of 5 patient samples by transferring an equal volume
(minimum of 50 μL) of each patient sample into an empty sterile tube. Mix by
gently pipetting up and down.

7. To each well containing 30 μL of rehydrated master mix, add 10 μL of pooled
direct patient sample.

8. Affix the appropriate optical caps.
9. Pulse spin the sealed 8-tube PCR strips to mix and bring liquid to the bottom.
10. Load 8-tube PCR strips into the real-time PCR platform and start run. Avoid

unnecessary delay once tubes are loaded.
11. Refer to Table 2 for result interpretation.

Note: For pixlTM Real-Time PCR Platform template file for Pooled Direct Patient
Sample addition (500003XMPDirExtpixlRev01.json), please refer to the section:
“Instrument Templates and Programming”: Install the BioGX Protocol on the
pixlTM Real-Time PCR Platform for download instructions. To manually program the
thermocycler, refer to Appendix F.
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QUALITY CONTROL

Each BioGX XfreeTM COVID-19 includes molecular primers and probes specific for the
detection of the endogenous extraction control, human RNase P gene. RNase P should
be present and detected in each patient sample. A non-naturally occurring
single-stranded RNA integrated into the lyophilized reagent serves as a PCR internal
amplification control (IAC). The IAC should be present and detected in every control and
SARS-CoV-2 negative patient sample. No external addition of Sample Processing Control
(SPC) or Internal Amplification Control (IAC) is required.

Laboratories must establish the number, type, and frequency of testing of control
materials according to guidelines or requirements of local, provincial, state, and federal
and/or country regulations or accreditation organizations in order to monitor the
effectiveness of the entire analytical process. It is generally recommended to run
appropriate positive and negative controls with every sample extraction/PCR run. It is
recommended that one external positive control be included with each RT-PCR run of
patient samples. The external negative control should consist of molecular grade water
and should be positive only for the IAC target. It is recommended that one external
negative control be included in each extraction batch (as applicable) and each RT-PCR
run of patient samples. BioGX recommends that the external negative control be
prepared prior to the external positive control in order to reduce the potential for
contamination as a result of control preparation. For general quality control guidance,
the user may wish to refer to CLSI MM314 and EP1215. The External Positive Control is
intended to monitor for substantial reagent failure. The External Negative Control is
intended to detect reagent or environmental contamination (or carry-over) by target
nucleic acids.

External positive and negative controls are available separately for the BioGX XfreeTM

COVID-19 kit. The External Control available from BioGX (BioGX Synthetic Nucleocapsid
Phosphoprotein gene region (N1) (BioGX catalog no. 720-0206) is treated as if it were a
patient sample. Refer to Tables 1A and 1B in the “Results Interpretation” section for the
interpretation of External Control assay results. As an alternative, inactivated
SARS-CoV-2 RNA available from ZeptoMetrix (catalog number NATSARS(CoV2)-ST) may
also be used as an external positive control.
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Preparation of BioGX External Control for Direct or Extracted Sample Testing

Applied BiosystemsTM, Bio-Rad, or Bio Molecular Systems platforms

Positive Control [BioGX SARS-CoV-2 (N1)]

Preparation of BioGX SARS-CoV-2 Synthetic Nucleocapsid Phosphoprotein Gene Region
(N1) external control (catalog no. 720-0206):
 
A single BioGX lyophilized SARS-CoV-2 (N1) control bead containing 100,000 copies/bead
should be serially diluted as described in the procedure below to achieve a final
concentration of 10,000 copies/mL (=10 copies/µL).

1. Rehydrate one BioGX lyophilized SARS-CoV-2 (N1) control bead with 100 µL of
molecular grade water. Slowly pipette up and down 5 times to homogenize and
discard pipette tip. This will be the SARS-CoV-2 (N1) stock solution.

2. With a fresh pipette tip, prepare two microcentrifuge tubes for serial dilution by
adding 90 µL of molecular grade water to each. Label the tube caps with “N1-10”
and “N1-100” to represent the 1/10 dilution and 1/100 dilution of SARS-CoV-2
(N1) stock solution, respectively.  

3. With a fresh pipette tip, transfer 10 µL of the SARS-CoV-2 (N1) stock solution to
the first microcentrifuge tube labeled “N1-10”. Slowly pipette up and down 5
times to homogenize then discard the pipette tip.

4. With a fresh pipette tip, transfer 10 µL of the “N1-10” dilution to the second
microcentrifuge tube labeled “N1-100”. Slowly pipette up and down 5 times to
homogenize then discard the pipette tip. The microcentrifuge tube labeled
“N1-100” now contains SARS-CoV-2 (N1) control at 10,000 copies/mL.

Add 5 μL of SARS-CoV-2 (N1) control (50 copies/PCR reaction) from the microcentrifuge
tube labeled “N1-100” to each positive control well position(s) containing dispensed
master mix.

Negative Control (No Template) - Add 5 μL of molecular grade water to (1) well position
containing dispensed master mix.

All External Controls should yield the expected results (Table 1A). An External Negative
Control that yields a positive result is indicative of errant sample handling and/or
contamination. An External Positive Control that yields a negative result is indicative of a
specimen handling/preparation problem. Review the specimen handling/preparation
technique.
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An External Control that yields an Unresolved, Indeterminate, or Incomplete test result is
indicative of a reagent or a real-time PCR system failure. Check the platforms for any
error messages. Refer to the “Troubleshooting” section of the Applied BiosystemsTM

QuantStudioTM 5 Real-Time PCR System (0.2 mL 96-well)9, Applied BiosystemsTM

QuantStudioTM 5 Real-Time PCR System, 384-well9, Applied BiosystemsTM 7500 Fast Dx10

Real-Time PCR Instrument, Bio-Rad CFX96 TouchTM/CFX384 TouchTM 11 Real-Time PCR
Detection System and Bio Molecular Mic System13 Instruction Manuals for interpretation
of warning and error codes. If the problem persists, use reagents from an unopened
pouch or use a new assay kit.

For further reference, please reference the product insert for Lyophilized Control
Template Beads (BioGX Product Number Series 720-XXXX) which is available for
download at www.biogx.com by using the drop down menu at the top right of the home
page. Select "Education Center" then depending on your location select "Int. Product
Documents" or "U.S. Product Documents". Choose the appropriate product number
under "Template Controls".

Table 1A. Interpretation of BioGX external controls when run on Applied BiosystemsTM,
Bio-Rad, or Bio Molecular Systems platforms.

Control
Type

Applicability
for Monitoring

N1
Gene

N1
Expected

Ct
RNase P

RNase P
Expected

Ct
IAC

IAC
Expected Ct

Negative
Control -

Addition of
5 µL Water

Reagent and/or
environmental
contamination

-
Not

Detected
-

Not
Detected

+ Ct ≤30

N1 Positive
Control -

BioGX
Synthetic
Template
Control

Substantial
reagent failure

including
primer and

probe integrity

+ Ct ≤40 -
Not

Detected
+

Ct ≤30
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Preparation of BioGX External Controls - pixlTM Real-Time PCR Platform

Positive Control [BioGX SARS-CoV-2 (N1)] - Each lyophilized template bead should be
rehydrated with 500 μL of molecular grade water and mixed by pipetting up and down 5
times. Add 5 μL of the positive control to (1) well position containing dispensed master
mix.

Negative Control (No Template) - Addition of 5 μL of molecular grade water to (1) well
position containing dispensed master mix.

All External Controls should yield the expected results (Table 1B). An External Negative
Control that yields a positive result is indicative of errant sample handling and/or
contamination. An External Positive Control that yields a negative result is indicative of a
specimen handling/preparation problem. Review the specimen handling/preparation
technique.

An External Control that yields an Unresolved, Indeterminate, or Incomplete test result is
indicative of a reagent or a real-time PCR system failure. Check the pixlTM Real-Time PCR
Platform for any error messages. Refer to the “Troubleshooting” section of the pixlTM

Real-Time PCR Platform Instruction for Use Manual12 for interpretation of warning and
error codes. If the problem persists, use reagents from an unopened pouch or use a new
assay kit.

For further reference, please reference the product insert for Lyophilized Control
Template Beads (BioGX Product Number Series 720-XXXX) which is available for
download at www.biogx.com by using the drop down menu at the top right of the home
page. Select "Education Center" then depending on your location select "Int. Product
Documents" or "U.S. Product Documents". Choose the appropriate product number
under "Template Controls".
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Table 1B. Interpretation of BioGX external controls when run on pixlTM Real-Time PCR
Platform.

Control
Type

Applicability
for Monitoring

N1
Gene

N1
Expected

Ct
RNase P

RNase P
Expected

Ct
IAC

IAC
Expected Ct

Negative
Control -

Addition of
5 µL Water

Reagent and/or
environmental
contamination

-
Not

Detected
-

Not
Detected

+ Ct ≤30

N1 Positive
Control -

BioGX
Synthetic
Template
Control

Substantial
reagent failure

including
primer and

probe integrity

+ Ct ≤40 -
Not

Detected
+

Ct ≤30

Preparation of ZeptoMetrix External Positive Control for Extracted or Direct Samples
Preparation of ZeptoMetrix SARS-Related Coronavirus 2 (SARS-CoV-2 Isolate:
USA-WA1/2020) ZeptoMetrix catalog number:  NATSARS(COV2)-ST
 
ZeptoMetrix SARS-Related Coronavirus 2 (SARS-CoV-2) stock concentration of 1,000,000
(1,000 copies/ µL) should be serially diluted to achieve a final concentration of 10,000
copies/mL (10 copies/µL) for the extracted method:

1.     With a fresh pipette tip, prepare two microcentrifuge tubes for serial dilution by
adding 18 µL of molecular grade water to each tube. Label the tube caps
with “N1-10” and “N1-100” to represent the 10 times dilution and 100 times dilution
of stock to yield 100 copies /µL and 10 copies / µL, respectively.
2.     With a fresh pipette tip, transfer 2 µL of the ZeptoMetrix SARS-Related
Coronavirus 2 (SARS-CoV-2) stock solution to the first microcentrifuge tube
labeled “ZM-10”. Slowly pipette up and down 5 times to homogenize then discard
the pipette tip.
3.     With a fresh pipette tip, transfer 2 µL of the “N1-10” dilution to the second
microcentrifuge tube labeled “N1-100”. Slowly pipette up and down 5 times to
homogenize then discard the pipette tip. The microcentrifuge tube labeled “N1-100”
now contains ZeptoMetrix SARS-Related Coronavirus 2 (SARS-CoV-2) control at 10,
000 copies/mL. 
4.     Add 5 μL of SARS-CoV-2 (N1) control (50 copies/PCR reaction) from the
microcentrifuge tube labeled “N1-100” to each positive control well position(s)
containing dispensed master mix.
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Note: The BioGX SARS-CoV-2 and ZeptoMetrix SARS-CoV-2 positive controls, when
utilized as described (3,333 copies/mL) with the extracted workflow, may not
sufficiently evaluate integrity of the assay reagents and could lead to false specimen
results.

RESULTS INTERPRETATION

Applied BiosystemsTM QuantStudioTM 5 Real-Time PCR System (0.2 mL 96-well)

Results are available under the “Results” tab in the QuantStudio Design and
Analysis Software. To download the data, the user can navigate to “Export” tab
and export the data in a variety of formats (*.xls, *.xlsx, and *.txt). Alternatively,
the user can navigate to “Print report” under “File” tab to preview and save the
report in *.PDF format. Please refer to the QuantStudioTM 5 Real-Time PCR
System user manual for further instructions9.

Applied BiosystemsTM QuantStudioTM 5 Real-Time PCR System, 384-well

Results are available under the “Results” tab in the QuantStudio Design and
Analysis Software. To download the data, the user can navigate to “Export” tab
and export the data in a variety of formats (*.xls, *.xlsx, and *.txt). Alternatively,
the user can navigate to “Print report” under “File” tab to preview and save the
report in *.PDF format. Please refer to the QuantStudioTM 5 Real-Time PCR
System, 384-well user manual for further instructions9.

Applied BiosystemsTM 7500 Fast Dx Real-Time PCR Instrument

Results are available under the “Results” tab in the SDS Software. To download
the data, the user can navigate to “File” then click “Export”. Choose “Results”,
select a desired file name to save, and check both boxes on the “Export Settings”
pop-up to export the results as a *.csv. Alternatively, the user can save a PDF of
the run report by navigating to the “Report“ section of the “Results” tab and
selecting the print icon. Please refer to the 7500 Fast Dx Real-Time PCR
Instrument user manual for further instructions10.

Bio-Rad CFX96 TouchTM Real-Time PCR Detection System
Results are available to view and download in pdf format by navigating to the
“Tools” tab and selecting the “Report” option on the Bio-Rad CFX Maestro
software in Data Analysis mode. Alternatively, the user can navigate to the
“Export” tab and export all raw data sheets in a variety of formats (*.xls, *.xlsx,
and *.txt). Please refer to the Bio-Rad CFX96 TouchTM Real-Time PCR Detection
System user manual for further instructions11.
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Bio-Rad CFX384 TouchTM Real-Time PCR Detection System

Results are available to view and download in pdf format by navigating to the
“Tools” tab and selecting the “Report” option on the Bio-Rad CFX Maestro
software in Data Analysis mode. Alternatively, the user can navigate to the
“Export” tab and export all raw data sheets in a variety of formats (*.xls, *.xlsx,
and *.txt). Please refer to the Bio-Rad CFX384 TouchTM Real-Time PCR Detection
System user manual for further instructions11.

pixlTM Real-Time PCR Platform
Results are available to view and download in .pdf format by navigating to the
“Results” tab, choosing the appropriate experiment, and selecting the “Export”
option on the pixlTM Real-Time PCR Platform software. Results are also available
to download in the following formats: *.csv, *.excel, *.temp, *.json, *.PDF, and
*.jpg. Please refer to the pixlTM Real-Time PCR Platform user manual for further
instructions12.

Bio Molecular Systems Mic Instrument

Results are available to view and download in .pdf format by navigating to the
“Results” tab, choosing the appropriate experiment, and selecting the “Export”
option on the Mic PCR software. Results are also available to download in the
following formats: *.csv, *.PDF, *.html, *.mht, *.rtf, *.docx, *.xlsx, *.xls, *.txt, and
*.image. Please refer to the Bio Molecular Systems Mic Instrument user manual
for further instructions13.
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Examination and Interpretation of Patient Specimen Results
Assessment of clinical specimen test results should be performed after the external
positive and negative controls have been examined and determined to be valid and
acceptable. If the controls are not valid, the patient results cannot be interpreted. The
list of expected results is outlined in Table 2. If results are obtained that do not follow
these guidelines, re-test sample or re-extract and re-test the sample if using extraction.
If repeat testing yields similar results, collect a fresh sample from the patient for testing.
In the presence of a high concentration positive result for the target, the IAC may or may
not amplify. This is normal. A positive test result does not necessarily indicate the
presence of viable infectious organisms. A positive result is indicative of the presence of
target nucleic acid. A negative test result does not preclude the presence of infectious
organisms and should not be used as the sole basis for treatment or other patient
management decisions.

REPEAT TESTING FOR INSTRUMENT FAILURE

In case of instrument failure, repeat testing can be performed by setting up a new run
using the original sample/specimen as described above in the “Specimen Preparation”
section.

Table 2. Interpretation of patient sample results16.

XfreeTM COVID-19
Direct RT-PCR

Results

N1 gene RNase P IAC
Result

InterpretationDetect
(+/-)

Expected
Ct

Detect
(+/-)

Expected Ct
Detect
(+/-)

Expected
Ct

SARS-CoV-2
POSITIVE

+ Ct≤40 + Ct≤36 +/- Ct≤30
Report as
POSITIVE

SARS-CoV-2
NEGATIVE

-
Not

Detected
+ Ct≤36 + Ct≤30

Report as
NEGATIVE

Indeterminant +/- Ct 0-40 - / Ct≥36 -/Ct≥36 + Ct≤30 Repeat Test*

Indeterminant +/- Ct 0-40 + Ct≤36 - / Ct≥30 - / Ct≥30 Repeat Test*

*Repeat the test by preparing a new test from the remaining patient sample collection and ensure the patient sample
and PCR master mix is dispensed properly in the well being analyzed. Repeat testing must yield RNaseP and IAC
detection without N1 detection to confirm a NEGATIVE result. However, if the same result is obtained upon a repeat
test, report results as INCONCLUSIVE and request a new sample collection.
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LIMITATIONS OF THE PROCEDURE

● This device is not designed as the sole means of diagnosis of infectious disease.
By the inherent nature of the technology used for nucleic acid extraction and
detection, nucleic acid can be detected from dead organisms. The Intended Use
is limited to the detection of the presence of the nucleic acid signature of an
organism, and not the diagnosis of disease or disease state.

● This product is intended for use with specimens collected using specimen
collection and transport devices listed in the “Equipment and Materials Required
But Not Provided” section.

● Incorrect test results may occur from improper specimen collection, handling or
storage, technical error, sample mix-up, or because the number of organisms in
the specimen is below the analytical sensitivity of the test. Careful compliance
with the BioGX XfreeTM COVID-19 instructions for use and the real-time PCR
platforms (ie. Applied BiosystemsTM QuantStudioTM 5 Real-Time PCR System (0.2
mL 96-well)9, Applied BiosystemsTM QuantStudioTM 5 Real-Time PCR System,
384-well9, Applied BiosystemsTM 7500 Fast Dx10 Real-Time PCR Instrument,
Bio-Rad CFX96 TouchTM/CFX384 TouchTM11 Real-Time PCR Detection System, pixlTM

Real-Time PCR Platform12, Bio Molecular Systems Mic Instrument13) are necessary
to avoid erroneous results.

● Good laboratory technique is essential for the proper performance of this assay.
Due to the high analytical sensitivity of this test, extreme care should be taken to
preserve the purity of all materials and reagents.

● A positive test result does not necessarily indicate the presence of viable
infectious organisms. A positive result is indicative of the presence of target
nucleic acid. A negative test result does not preclude the presence of infectious
organisms and should not be used as the sole basis for treatment or other
patient management decisions.

● As with all PCR-based in vitro diagnostic tests, extremely low levels of target
below the limit of detection of the assay may be detected, but such results may
not be reproducible.

● False negative results may occur due to loss of nucleic acid from inadequate
collection, transport or storage of specimens, or due to inadequate cell lysis
and/or extraction. The RNase P and IAC targets have been added to the test to
aid in the identification of properly collected specimens, specimens that contain
inhibitors to PCR amplification, and as a control for reagent integrity and of the
assay system as a whole.

● The BioGX XfreeTM COVID-19 results may sometimes be Unresolved or
Indeterminate due to a lack of RNase P and/or IAC detection. Instrument failure
could also contribute to an incomplete run result and require retesting that can
lead to a delay obtaining final results.
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● Mutations or polymorphisms in primer- or probe-binding regions may affect
detection of new or unknown SARS-CoV-2 variants resulting in a false negative
result with the BioGX XfreeTM COVID-19.

● The BioGX XfreeTM COVID-19 requires the use of three (3) optical channels on the
Applied BiosystemsTM QuantStudioTM 5 Real-Time PCR System (0.2 mL 96-well),
Applied BiosystemsTM QuantStudioTM 5 Real-Time PCR System, 384-well9, Applied
BiosystemsTM 7500 Fast Dx Real-Time PCR Instrument, Bio-Rad CFX96
TouchTM/CFX384 TouchTM Real-Time PCR Detection System, pixlTM Real-Time PCR
Platform, Bio Molecular Systems Mic Instrument.

PERFORMANCE CHARACTERISTICS

Analytical Sensitivity - Direct Patient Sample
Limit of Detection (LoD) was determined by serially diluting quantified inactivated
SARS-CoV-2 (USA-WA1/2020; Zeptometrix catalog number NATSARS(CoV2)-ST) into
negative NP swabs samples in Copan UTM, Copan ESwab, VTM and saline transport
media. The LoD confirmation for each collection device (i.e. Copan UTM, Copan ESwab,
VTM or saline) were confirmed by reliably detecting the number of inactivated
SARS-CoV-2 viruses/mL in ≥95% of the samples tested. LoD confirmation was performed
using the following real-time PCR platforms: Applied BiosystemsTM QuantStudioTM 5
Real-Time PCR System (0.2 mL 96-well), Applied BiosystemsTM QuantStudioTM 5
Real-Time PCR System, 384-well, Applied BiosystemsTM 7500 Fast Dx Real-Time PCR
Instrument, Bio-Rad CFX96 TouchTM/CFX384 TouchTM Real-Time PCR Detection System,
pixlTM Real-Time PCR Platform, Bio Molecular Systems Mic Instrument. The LoD for the
assay using Direct patient samples on the validated platforms ranged from 1,000 - 3,000
copies/mL (Table 3).
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Table 3. REF: 500-003-XMP LoD confirmation - direct addition of contrived samples using
SARS-CoV-2 USA-WA1/2020.

Instrument Transport Media
Concentration
[Copies/ mL]

N1-gene RNase P IAC

Agreement with
Expected Result

(% Positive)
Mean Ct Mean Ct Mean Ct

Applied BiosystemsTM

QuantStudioTM 5
(0.2 mL 96-well)

UTM/VTM 1000 19/20 (95%) 35.1 30.0 24.1

Saline 1000 19/20 (95%) 34.2 31.4 24.4

ESwab 3000 20/20 (100%) 34.1 29.2 25.4

Applied BiosystemsTM

QuantStudioTM 5
384-well

UTM/VTM 2,000 20/20 (100%) 34.6 31.8 23.1

Saline 2,500 19/20 (95%) 34.8 28.1 19.0

ESwab 3,000 20/20 (100%) 32.9 31.9 16.3

Applied BiosystemsTM

7500 Fast Dx

UTM/VTM 1000 20/20 (100%) 34.6 30.6 26.4

Saline 1000 20/20 (100%) 35.3 30.8 26.2

ESwab 2000 20/20 (100%) 34.6 28.8 28.1

Bio-Rad
CFX96 TouchTM

UTM/VTM 1500 19/20 (95%) 36.4 30.4 27.4

Saline 1500 20/20 (100%) 35.6 33.2 27.9

ESwab 1500 19/20 (95%) 35.9 30.1 28.3

Bio-Rad
CFX384 TouchTM

UTM/VTM 1000 19/20 (95%) 36.3 31.2 27.2

Saline 2000 20/20 (100%) 36.6 32.9 27.5

ESwab 3000 20/20 (100%) 36.1 28.6 29.0

pixlTM Real-Time PCR
Platform

UTM/VTM 2000 19/20 (95%) 31.1 31.9 25.6

Saline 3000 19/20 (95%) 32.1 29.3 25.2

Bio Molecular Systems
Mic

UTM/VTM 1000 21/22 (96%) 34.0 29.2 26.8

Saline 1500 22/22 (100%) 33.6 31.2 26.4

ESwab 2000 22/22 (100%) 33.9 29.1 27.3
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Analytical Sensitivity - Extracted Patient Sample
Limit of Detection (LoD) was determined by serially diluting quantified inactivated
SARS-CoV-2 (USA-WA1/2020; Zeptometrix catalog number NATSARS(CoV2)-ST) into
negative NP swabs samples in the respective transport media types (i.e. Copan ESwab,
Copan UTM, saline or VTM) extracted with Qiagen Viral RNA Mini Kit. The LoD
confirmation for each collection device was confirmed by reliably detecting the number
of inactivated SARS-CoV-2 viruses/mL in ≥95% of the samples tested. LoD confirmation
was performed using the following real-time PCR platforms: Applied BiosystemsTM

QuantStudioTM 5 Real-Time PCR System (0.2 mL 96-well), Applied BiosystemsTM

QuantStudioTM 5 Real-Time PCR System, 384-well, Applied BiosystemsTM 7500 Fast Dx
Real-Time PCR Instrument, Bio-Rad CFX96 TouchTM/CFX384 TouchTM Real-Time PCR
Detection System, pixlTM Real-Time PCR Platform, Bio Molecular Systems Mic
Instrument. The LoD for the assay using Extracted Patient Samples on the validated
platforms ranged from 125 - 750 copies/mL (Table 4).
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Table 4. REF: 500-003-XMP LoD confirmation - extracted* contrived samples using SARS-CoV-2
USA-WA1/2020.

Instrument Transport Media
Concentration
[Copies/ mL]

N1-gene RNase P IAC

Agreement with
Expected Result

(% Positive)
Mean Ct Mean Ct Mean Ct

Applied BiosystemsTM

QuantStudioTM 5
(0.2 mL 96-well)

UTM/VTM 250 20/20 (100%) 33.9 25.5 23.5

Saline 250 20/20 (100%) 34.6 29.3 23.5

ESwab 500 19/20 (95%) 35.2 28.2 23.5

Applied BiosystemsTM

QuantStudioTM 5
384-well

UTM/VTM 250 19/20 (95%) 32.0 26.4 15.8

Saline 250 19/20 (95%) 34.8 27.8 17.4

ESwab 500 19/20 (95%) 34.7 27.9 23.9

Applied BiosystemsTM

7500 Fast Dx

UTM/VTM 125 19/20 (95%) 35.2 28.4 26.1

Saline 250 19/20 (95%) 34.7 29.2 26.1

ESwab 250 19/20 (95%) 35.3 27.1 26.0

Bio-Rad
CFX96 TouchTM

UTM/VTM 250 20/20 (100%) 35.8 25.7 26.7

Saline 250 20/20 (100%) 36.0 29.5 26.9

ESwab 250 19/20 (95%) 36.3 27.1 26.8

Bio-Rad
CFX384 TouchTM

UTM/VTM 500 20/20 (100%) 36.7 26.9 26.5

Saline 500 20/20 (100%) 36.5 29.6 26.4

ESwab 500 20/20 (100%) 36.9 29.5 26.6

pixlTM Real-Time PCR
Platform

UTM/VTM 250 20/20 (100%) 33.3 29.7 24.8

Saline 500 20/20 (100%) 32.5 27.6 25.0

Bio Molecular Systems
Mic

UTM/VTM 750 22/22 (100%) 33.6 27.3 25.3

Saline 750 22/22 (100%) 33.6 29.3 25.2

ESwab 500 22/22 (100%) 33.5 28.6 26.2

*Qiagen Viral RNA Mini extraction kit used according to manufacturer recommendations (i.e. 140µL sample processed

and eluted in 50µL).
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Analytical Sensitivity - Pooled Direct Patient Sample
Limit of Detection (LoD) was determined by serially diluting quantified inactivated
SARS-CoV-2 (USA-WA1/2020; Zeptometrix catalog number NATSARS(CoV2)-ST) into
negative NP swabs samples collected in the respective transport media types (i.e. Copan
ESwab, Copan UTM, saline or VTM). To create contrived 5 patient pools for each
transport media, four individual negative NP swab samples were pooled and combined
with a fifth sample that was spiked with a defined concentration of quantified
SARS-CoV-2 virus. The LoD confirmation for pooled samples in each respective collection
device was confirmed by reliably detecting the number of inactivated SARS-CoV-2
viruses/mL in ≥95% of the samples tested. LoD confirmation was performed using the
following real-time PCR platforms: Applied BiosystemsTM QuantStudioTM 5 Real-Time PCR
System (0.2mL 96-well), Applied BiosystemsTM 7500 Fast Dx Real-Time PCR Instrument,
Bio-Rad CFX96 TouchTM Real-Time PCR Detection System and pixlTM Real-Time PCR
Platform. The LoD for the assay using Pooled Direct Patient Samples on the validated
platforms ranged from 2,000 - 6,000 copies/mL (Table 5).

Table 5. REF: 500-003-XMP LoD confirmation - pooled contrived samples using SARS-CoV-2
USA-WA1/2020.

Instrument Transport Media
Concentration
[Copies/ mL]

N1-gene RNase P IAC

Agreement with
Expected Result

(% Positive)
Mean Ct Mean Ct Mean Ct

Applied BiosystemsTM

QuantStudioTM 5
(0.2 mL 96-well)

UTM/VTM 4,000 20/20 (100%) 34.55 30.19 23.19

Saline 3,000 19/20 (95%) 34.11 29.42 20.86

ESwab 4,000 20/20 (100%) 34.03 30.65 23.70

Applied BiosystemsTM

7500 Fast Dx

UTM/VTM 5,000 20/20 (100%) 36.84 33.68 28.78

Saline 2,000 20/20 (100%) 36.07 31.86 25.87

ESwab 4,000 20/20 (100%) 35.81 33.05 28.29

Bio-Rad
CFX96 TouchTM

UTM/VTM 5,000 20/20 (100%) 37.22 31.24 27.07

Saline 3,000 19/20 (95%) 37.10 31.07 26.05

ESwab 6,000 20/20 (100%) 34.80 35.47 30.65

pixlTM Real-Time PCR
Platform

UTM/VTM 4,000 19/20 (95%) 33.50 31.40 25.60

Saline 5,000 19/20 (95%) 33.30 30.30 25.20
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Inclusivity (in-silico)
The BioGX SARS-CoV-2 N1 primers and probes are identical in sequence to those
reported in the CDC 2019-Novel Coronavirus (2019-nCoV) Real-Time RT-PCR Diagnostic
Panel. The CDC reported an in-silico analysis of primer and probe sequences within their
IFU (CDC-006-00019, Rev 05)3. An alignment was performed with the oligonucleotide
primer and probe sequences of the CDC 2019 nCoV Real-Time RT-PCR Diagnostic Panel
with all publicly available nucleic acid sequences for 2019-nCoV in GenBank as of June
20, 2020, to demonstrate the predicted inclusivity of the CDC 2019 nCoV Real-Time
RT-PCR Diagnostic panel. All the alignments show >99% identity of the CDC panel to the
available 2019-nCoV sequences with the exception of one sequence with a mismatch
frequency of >1% in the N1 probe, all other sequences assessed had mismatch
frequencies <1%. From the mismatch frequencies with <1%, two separate deposited
sequences were observed to have two mismatches in the N1 probe and N1 reverse
primer.

SARS-CoV-2 Alpha variants [B.1.1.7 lineage, Qx]: To confirm the test’s ability to detect
the SARS-CoV-2 Alpha variants first observed circulating in the United Kingdom, BioGX
ran in-silico inclusivity analysis against the Alpha variant sequences present in the GISAID
database as of March 31, 2022. The available SARS-CoV-2 Alpha variant genomes
demonstrated >99% homology to the N gene region and are expected to be detected by
the assay. The in-silico analysis shows the analyzed SARS-CoV-2 Alpha variants do not
possess mutations within the targeted region of the N gene that are expected to affect
detection of SARS-CoV-2 by the BioGX XfreeTM COVID-19 Direct RT-PCR.

SARS-CoV-2 Beta variants [B.1.351, B.1.351.2, B.1.351.3 lineages]: To confirm the BioGX
test’s ability to detect the SARS-CoV-2 Beta variants, first observed circulating in South
Africa, BioGX ran in-silico inclusivity analysis against the Beta variant sequences present
in the GISAID database as of March 31, 2022. The available SARS-CoV-2 Beta variant
genomes demonstrated >99% homology to the N gene region and are expected to be
detected by the assay. The in-silico analysis of the currently circulating strains of the
SARS-CoV-2 Beta variants do not possess mutations within the the targeted region of the
N gene that are expected to affect detection of SARS-CoV-2 by the BioGX XfreeTM

COVID-19 Direct RT-PCR.
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SARS-CoV-2 Gamma variants [P.1 and P.1.x lineages]: To confirm the BioGX test’s ability
to detect the SARS-CoV-2 Gamma variants, first observed circulating in Brazil, BioGX ran
in-silico inclusivity analysis against the Gamma variant sequences present in the GISAID
database as of March 31, 2022. The available SARS-CoV-2 Gamma variant genomes
demonstrated >99% homology to the N gene region are expected to be detected by the
assay. The in-silico analysis of the currently circulating strains of the SARS-CoV-2 Gamma
variant do not possess mutations within the the targeted region of the N gene that are
expected to affect detection of SARS-CoV-2 by the BioGX XfreeTM COVID-19 Direct
RT-PCR.

SARS-CoV-2 Delta variants [B.1.617.2 and AY.x lineages]: To confirm the BioGX test’s
ability to detect the SARS-CoV-2 Delta variants, first observed circulating in India, BioGX
ran in-silico inclusivity analysis against the Delta variant sequences present in the GISAID
database as of March 31, 2022. The available SARS-CoV-2 Delta variant genomes
demonstrated >99% homology to the N gene region and are expected to be detected by
the assay. The in-silico analysis of the currently circulating strains of the SARS-CoV-2
Delta variant do not possess mutations within the the targeted region of the N gene that
are expected to affect detection of SARS-CoV-2 by the BioGX XfreeTM COVID-19 Direct
RT-PCR.

SARS-CoV-2 Omicron variants [B.1.529 and BAx lineages]: To confirm the BioGX test’s
ability to detect the SARS-CoV-2 Omicron variants, first observed circulating in South
Africa, BioGX ran in-silico inclusivity analysis against the Omicron variant sequences
present in the GISAID database as of March 31, 2022. The available SARS-CoV-2 Omicron
variant genomes demonstrated >99% homology to the N gene region and are expected
to be detected by the assay. The in-silico analysis of the currently circulating strains of
the SARS-CoV-2 Omicron variant do not possess mutations within the the targeted
region of the N gene that are expected to affect detection of SARS-CoV-2 by the BioGX
XfreeTM COVID-19 Direct RT-PCR.

Cross-Reactivity (Analytical Specificity)

Select high priority organisms represented in a respiratory specimen were evaluated
using the oligonucleotide primers and probes in BioGX XfreeTM COVID-19 by in-silico
BLASTn alignments with an expected threshold of 5000 for potential cross-reactivity
(Table 6). The combination of primers and probes did not produce significant sequence
homology or identity which would result in cross-reactivity reporting to any of the
selected high priority respiratory specimens. The primers and probes were further
evaluated against high priority pathogens within the same genetic family (e.g. human
coronavirus strains, MERS-coronavirus). The resultant in-silico analysis showed no
significant homology to pathogens from the same genetic family (excluding SARS-CoV-2).
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Microbial Interference
None of the high priority microbial species above (also refer to Table 6), which could
potentially be present in the clinical specimens, showed any in-silico homology to the
primers and probes used in the assay, and the BioGX SARS-CoV-2 N1 primers and probes
are identical in sequence to those reported in the CDC 2019-Novel Coronavirus
(2019-nCoV) Real-Time RT-PCR Diagnostic Panel, therefore a microbial interference study
specifically against these strains is not required per US FDA recommendations.3,16

Additionally, during the development and validation of the assay, SARS-CoV-2 negative
NP swabs obtained in kind, were collected from individuals presenting with illness,
de-identified of patient information, and tested with the BioGX XfreeTM COVID-19. These
patient samples resulted in 0% false positive detection. Additionally, in the event a
sufficient microbial contamination were to occur due to an improperly collected
specimen, the IAC would indicate if the excessive microbial load would inhibit RNA
reverse transcription, amplification, and detection.

Table 6. XfreeTM COVID-19 Direct RT-PCR primers and probes in-silico analysis of high priority
organisms.

Organism SARS-CoV-2 (N1)
Percent Identity

Organism SARS-CoV-2 (N1)
Percent Identity

Human coronavirus 229E 0% Chlamydia pneumoniae 0%

Human coronavirus OC43 0% Haemophilus influenzae 0%

Human coronavirus HKU1 0% Legionella pneumophila 0%

Human coronavirus NL63 0% Mycobacterium tuberculosis 0%

MERS-coronavirus 0% Streptococcus pneumoniae 0%

SARS-coronavirus 0% Streptococcus pyogenes 0%

Adenovirus 0% Bordetella pertussis 0%

Human Metapneumovirus (hMPV) 0% Mycoplasma pneumoniae 0%

Parainfluenza virus 1-4 0% Pneumocystis jirovecii (PJP) 0%

Influenza A & B 0% Candida albicans 0%

Enterovirus (e.g. EV68) 0% Pseudomonas aeruginosa 0%

Respiratory syncytial virus 0% Staphylococcus epidermidis 0%

Rhinovirus 0% Streptococcus salivarius 0%

Interfering Substances
Potential interfering substances were spiked into pooled Copan UTM negative
nasopharyngeal swab samples containing SARS-CoV-2 (USA-WA1/2020; Zeptometrix
catalog number NATSARS(CoV2)-ST) at 5X LoD (5,000 copies/mL). Table 7 summarizes
the replicate runs (n=3) conducted for each substance with the indicated concentrations.
All runs were conducted with direct sample addition to the master mix and analyzed
with both the Applied BiosystemsTM QuantStudioTM 5 Real-Time PCR System and Bio-Rad
CFX96 TouchTM Real-Time PCR Detection System.
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The BioGX XfreeTM COVID-19 assay utilizes a single stranded RNA Internal Amplification
Control (IAC) included in every reaction. The single stranded RNA IAC shows conditions
for amplification within the reaction were suitable for reverse transcription, PCR
amplification, and generation of fluorescence to take place. In the event a Direct tested
sample contains interfering substances which are detrimental to the real time PCR, by
either inhibiting reverse transcription or cDNA polymerization, the IAC would fail to
amplify and report. The results interpretation of such a sample as an indeterminate,
requires the analyst to first retest the sample, and if it is still inhibitory to collect another
sample for testing. A similar strategy is employed for extracted samples. As such, false
negative results due to inhibition are mitigated by the incorporation of the single
stranded RNA IAC into each test to identify inhibition, and providing a reflexive testing
strategy that indicates need for new sample collection or re-testing with established
extraction procedure.

Table 7. Analysis of interfering substances.

Potential Interfering substance
Final concentration

(in sample)

Agreement with expected results
Applied BiosystemsTM

QuantStudioTM 5

(0.2 mL 96-well)

Bio-Rad CFX96

TouchTM

Positive

NP

Negative

NP

Positive

NP

Negative

NP

None N/A 100% 100% 100% 100%

Mucin (bovine submaxillary gland, type I-S) 2.5 mg/mL 100% 100% 100% 100%

Mucin (bovine submaxillary gland, type I-S) 1.25 mg/mL 100% 100% 100% 100%

Nasacort 10% v/v 100% 100% 100% 100%

NeilMed NasoGEL 1.25% w/v 100% 100% 100% 100%

Similasan Nasal Allergy ReliefTM 15% v/v 100% 100% 100% 100%

Saline Nasal Spray 15% v/v 100% 100% 100% 100%

Act dry mouth lozenges 0.04 g/mL 100% 100% 100% 100%

Chloraseptic® Spray 10% v/v 100% 100% 100% 100%

Cepacol Extra Strength Cherry Lozenges
0.046 g/mL
(0.15mg/mL
Benzocaine)

100% 100% 100% 100%

Chloraseptic Lozenges
0.071 g/mL
(0.12mg/mL
Benzocaine)

100% 100% 100% 100%

Halls Cough drops
0.062 g/mL

(0.15 mg/mL
Menthol)

100% 100% 100% 100%
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Potential Interfering substance
Final concentration

(in sample)

Agreement with expected results

Applied BiosystemsTM

QuantStudioTM 5
(0.2 mL 96-well)

Bio-Rad CFX96
TouchTM

Positive
NP

Negative
NP

Positive
NP

Negative
NP

Nature’s Bounty® Zinc (50mg) 10µg/mL 100% 100% 100% 100%

Nyquil 10% v/v 100% 100% 100% 100%

Robitussin 10% v/v 100% 100% 100% 100%

Flonase 5% v/v 100% 100% 100% 100%

Ethanol 5% v/v 100% 100% 100% 100%

ORIGINAL LISTERINE® Mouthwash 5% v/v 100% 100% 100% 100%

Colgate Toothpaste Original 1% v/v 100% 100% 100% 100%

Mupirocin Ointment (Bactroban) 5 mg/mL 100% 100% 100% 100%

Tobramycin (Antibiotic) 100 ng/mL 100% 100% 100% 100%

Oseltamivir (Tamiflu API) 3.3 mg/mL 100% 100% 100% 100%

Emergen-C Vitamin C Drink - Super Orange 10% v/v 100% 100% 100% 100%

Petroleum jelly (Vaseline) 1% w/v 100% 100% 100% 100%

Tobacco 1% v/v 100% 100% 100% 100%

Tobacco 0.5% v/v 100% 100% 100% 100%

Human DNA 10 ng/µL 100% 100% 100% 100%

White blood cells
10% v/v

(4.5x105-1.10x106/mL)
100% 100% 100% 100%

Whole Blood 2.5% v/v 100% 100% 100% 100%

Whole Blood 1.0% v/v 100% 100% 100% 100%
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Clinical Performance

Clinical performance of the BioGX XfreeTM COVID-19 assay (REF: 500-003-XMP) was
evaluated using clinical samples previously identified and confirmed with the US
FDA-EUA comparator method: LineaTM COVID-19 Assay Kit. Positive Percent Agreement
(PPA) and Negative Percent Agreement (NPA) was determined using 60 individual
positive and 35 individual negative clinical samples, collected by qualified healthcare
professionals. Samples were handled as described in the package insert of the collection
device and stored frozen until use.

Testing with Direct Patient Sample Addition
The clinical samples were tested by Direct sample addition (5 µL of clinical sample
transferred directly into 15 µL of the BioGX XfreeTM COVID-19 mastermix). Clinical sample
analysis on the Applied BiosystemsTM QuantStudioTM 5 (0.2 mL 96-well) from high,
medium, and low positive clinical patient samples (n=60) and negative clinical patient
samples (n=35), Direct sample addition achieved a 95.45% PPA and 100% NPA when
compared to the comparator method (Table 8).

Testing with Extracted Patient Samples
The clinical samples were extracted with Qiagen Viral RNA Mini Kit following the
manufacturer’s recommendations where 140 µL of clinical sample is extracted and then
eluted with 50 µL RNase-free water. The eluted nucleic acid template (5 µL) is added to
10 µL of the BioGX XfreeTM master mix. Extracted high, medium, and low positive clinical
patient samples (n=60) and negative clinical patient samples (n=35) yielded PPA and NPA
of 100% and 94.29%, respectively, when analyzed on the Applied BiosystemsTM

QuantStudioTM 5 (0.2 mL 96-well) (Table 9).
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Table 8. REF: 500-003-XMP Clinical performance percent agreement of Direct sample addition with
Applied BiosystemsTM QuantStudioTM 5 Real-Time PCR System (0.2 mL 96-well) and comparator
method (LineaTM COVID-19 assay).

QuantStudioTM 5 (0.2 mL 96-well) Direct
Sample Addition

Comparator Method:
LineaTM COVID-19 assay

XfreeTM COVID-19 Direct RT-PCR Positive Negative

Positive 57 0

Negative 3* 35

Positive Percent Agreement (95%CI) 95.0% (86.3-98.3%)

Negative Percent Agreement (95%CI) 100% (90.1-100.0%)

*The three direct samples with discordant results were identified as positive by the comparator method with Ct values
between 37.6 & 40.5.

Table 9. REF: 500-003-XMP Clinical performance percent agreement of Extracted sample
addition with Applied BiosystemsTM QuantStudioTM 5 Real-Time PCR System (0.2 mL 96-well) and
comparator method (LineaTM COVID-19 assay).

QuantStudioTM 5 (0.2 mL 96-well)
Qiagen Extracted Nucleic Acid

Comparator Method:
LineaTM COVID-19 assay

XfreeTM COVID-19 Direct RT-PCR Positive Negative

Positive 60 2*

Negative 0 33

Positive Percent Agreement (95%CI) 100% (94.0-100.0%)

Negative Percent Agreement (95%CI) 94.3% (81.4-98.4%)

*The two samples that tested positive with the BioGX XfreeTM COVID-19 assay (REF: 500-003-XMP) and negative with
the comparator method were tested with a third, highly sensitive RT-PCR US FDA-EUA authorized test. Both samples
tested positive with the second RT-PCR US FDA-EUA authorized test.
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APPENDIX A

Applied BiosystemsTM QuantStudioTM 5 Real-Time PCR System (0.2 mL 96-well) -
Thermocycling Programing

Direct Patient Sample (20 μL reaction volume)

Please refer to the following steps for QuantStudioTM 5 Real-Time PCR System manual
programming specific for Direct Patient sample testing.

1. Open the QuantStudioTM Design and Analysis Software v1.5.1
2. Select the “Create New Experiment” option
3. Within the properties tab, select the following properties to filter:

a. Name: User defined or 500003XMPDirectQS5v2
b. Instrument Type: QuantStudioTM 5 Real-Time PCR System
c. Block Type: 96-Well 0.2 mL
d. Experiment type: Standard Curve
e. Chemistry: TaqMan Reagents
f. Run mode: Standard

4. Run Method (Method Tab)
a. Change the Reaction Volume to 20.0 μL
b. Temperature of the enabled heated cover will remain at 105.0 °C
c. Within the “PCR Stage “ section of the thermocycling parameters, an

additional step will need to be added by bringing the mouse pointer
above “Step 2” will allow the “+” and “-” buttons to become visible.

d. Click the “+” button to add “Step 3” to the “PCR Stage”.
e. Going back to the first hold stage enter the following parameters (Table

A1):
i. Hold Stage: Step 1

1. 1.6 ramp rate
2. 46°C
3. 20 minutes

ii. Hold Stage: Step 2
1. 1.6 ramp rate
2. 95°C
3. 5 minutes

iii. PCR Stage: Step 1
1. 1.6 ramp rate
2. 95°C
3. 3 seconds
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iv. PCR Stage: Step 2
1. 1.6 ramp rate
2. 62°C
3. 20 seconds
4. Scanning is turned ON by clicking the camera icon (dark blue
when ON).

v. PCR Stage: Step 3
1. 1.6 ramp rate
2. 70°C
3. 5 seconds
4. Scanning is turned OFF by clicking the camera icon (light
blue when OFF).

vi. Number of cycles set to 40 (located at the bottom of the “PCR Stage”
section).

Table A1. QuantStudioTM 5 thermocycling summary - Direct Patient Sample.

PCR Cycle Summary

Hold Stage PCR Stage

Conditions Step 1 Step 2 Step 1 Step 2 Step 3

Ramp Rate (°C/s) 1.6 1.6 1.6 1.6 1.6

Temperature (°C) 46 95 95 62 70

Duration (Min:sec) 20:00 5:00 0:03 0:20 0:05

Detection OFF OFF OFF ON OFF

No. of PCR Cycles 1 1 40

5. Plate Setup (Plate Tab)
a. Under the “Plate Attribute” section of the Quick Setup tab, change the

Passive Reference to “NONE”.
b. On the left side of the screen (next to Quick Setup), choose “Advanced

Setup”.
c. In the “Targets” section, click on the “Add” box and add two targets for a

total of three. Rename “Target 1” as “RNaseP”.
d. Click the associated reporter box below the Reporter tab and, from the

drop down menu, choose “FAM”.
e. Click on the “Target 2” box and change the name to “N1”.
f. Click the associated reporter box below the Reporter tab and, from the

drop down menu, choose “ROX”.
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g. Click on the “Target 3” box and change the name to “IAC”.
h. Click the associated reporter box below the Reporter tab and, from the

drop down menu, choose “Cy5”
i. Ensure that the “Quencher” tab for all three targets is set to “None”.
j. Highlight all the wells that you intend to use and ensure that the boxes

besides the three targets are selected and in the task select “U” for
unknown. This should populate the plate on the right side of the screen
with each target.

k. To name your wells by sample name, select the appropriate well on the
right side of the screen. Under the “Samples” tab on the left side, click on
the current sample name and rename to whatever is desired for the
experiment. Check the box besides the sample name: the names will
populate on the right side.

l. To add additional sample names, click “Add” on the samples tab and
repeat the instructions above.

m. Click on the “Results” tab on the top of the screen
6. Threshold Setup (Results Tab)

a. Navigate to the “Results” tab and select the settings wheel besides
“Analyze” in the upper right corner.

b. Click on target “N1” and uncheck the “Ct Settings to Use: Default
Settings” box directly to the right. Then uncheck the “Automatic
Threshold” box: set the threshold to 10,000.

c. Click on target “RNaseP” and uncheck the “Ct Settings to Use: Default
Settings” box directly to the right. Then uncheck the “Automatic
Threshold” box: set the threshold to 25,000.

d. Click on target “IAC” and uncheck the “Ct Settings to Use: Default
Settings” box directly to the right. Then uncheck the “Automatic
Threshold” box: set the threshold to 5,000.

e. Click “Apply” in the bottom right corner.
7. Save File

a. Navigate to the “File” tab and choose “Save As”. Name the file
‘500003XMPDirectQS5v2’ and ensure it is saved as an *.edt file.

8. Run File
a. Select “File” then ”Open”.
b. Select your chosen *.edt file.
c. Navigate to the “Run” tab, and click the dropdown arrow next to

“Start Run”. Ensure the name of the instrument is your preferred
instrument. You will be prompted to enter a name for the run.

d. Insert the desired run name and click “Start Run”.
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Applied BiosystemsTM QuantStudioTM 5 Real-Time PCR System (0.2 mL 96-well) -
Thermocycling Programing

Extracted Patient Sample (15 μL reaction volume)

Please refer to the following steps for QuantStudioTM 5 Real-Time PCR System manual
programming specific for Extracted Patient sample testing.

1. Open the QuantStudioTM Design and Analysis Software v1.5.1

2. Select the “Create New Experiment” option

3. Within the properties tab, select the following properties to filter:
a. Name: User defined or 500003XMPExtractQS5v2
b. Instrument Type: QuantStudioTM 5 Real-Time PCR System
c. Block Type: 96-Well 0.2 mL
d. Experiment type: Standard Curve
e. Chemistry: TaqMan Reagents
f. Run mode: Standard

4. Run Method (Method Tab)
a. Change the Reaction Volume to 15.0 μL
b. Temperature of the enabled heated cover will remain at 105.0 °C
c. Within the “PCR Stage “ section of the thermocycling parameters, an

additional step will need to be added by bringing the mouse pointer
above “Step 2” will allow the “+” and “-” buttons to become visible.

d. Click the “+” button to add “Step 3” to the “PCR Stage”.
e. Going back to the first hold stage enter the following parameters (Table

A2):
i. Hold Stage: Step 1

1. 1.6 ramp rate
2. 46°C
3. 20 minutes

ii. Hold Stage: Step 2
1. 1.6 ramp rate
2. 95°C
3. 5 minutes

iii. PCR Stage: Step 1
1. 1.6 ramp rate
2. 95°C
3. 3 seconds
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iv. PCR Stage: Step 2
1. 1.6 ramp rate
2. 62°C
3. 20 seconds
4. Scanning is turned ON by clicking the camera icon (dark blue
when ON).

v. PCR Stage: Step 3
1. 1.6 ramp rate
2. 70°C
3. 5 seconds
4. Scanning is turned OFF by clicking the camera icon (light
blue when OFF).

vi. Ensure the number of cycles is set to 40 (located at the bottom
border of the PCR Stage).

Table A2. QuantStudioTM 5 thermocycling summary - Extracted Patient Sample.

PCR Cycle Summary

Hold Stage PCR Stage

Conditions Step 1 Step 2 Step 1 Step 2 Step 3

Ramp Rate (°C/s) 1.6 1.6 1.6 1.6 1.6

Temperature (°C) 46 95 95 62 70

Duration (Min:sec) 20:00 5:00 0:03 0:20 0:05

Detection OFF OFF OFF ON OFF

No. of PCR Cycles 1 1 40

5. Plate Setup (Plate Tab)
a. Under the “Plate Attribute” section of the Quick Setup tab, change the

Passive Reference to “NONE”.
b. On the left side of the screen (next to Quick Setup), choose “Advanced

Setup”.
c. In the “Targets” section, click on the “Add” box and add two targets for a

total of three. Rename “Target 1” as “RNaseP”.
d. Click the associated reporter box below the Reporter tab and, from the

drop down menu, choose “FAM”.
e. Click on the “Target 2” box and change the name to “N1”.
f. Click the associated reporter box below the Reporter tab and, from the

drop down menu, choose “ROX”.
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g. Click on the “Target 3” box and change the name to “IAC”.
h. Click the associated reporter box below the Reporter tab and, from the

drop down menu, choose “Cy5”
i. Ensure that the “Quencher” tab for all three targets is set to “None”.
j. Highlight all the wells that you intend to use and ensure that the boxes

besides the three targets are selected. In the “Task” section select “U” for
unknown. This should populate the plate on the right side of the screen
with each target.

k. To name your wells by sample name, select the appropriate well on the
right side of the screen. Under the “Samples” tab on the left side, click on
the current sample name and rename to whatever is desired for the
experiment. Check the box besides the sample name: the names will
populate on the right side.

l. To add additional sample names, click “Add” on the samples tab and
repeat the instructions above.

m. Click on the “Results” tab on the top of the screen

6. Threshold Setup (Results Tab)
a. Navigate to the “Results” tab and select the settings wheel besides

“Analyze” in the upper right corner.
b. Click on target “N1” and uncheck the “Ct Settings to Use: Default

Settings” box directly to the right. Then uncheck the “Automatic
Threshold” box: set the threshold to 10,000.

c. Click on target “RNaseP” and uncheck the “Ct Settings to Use: Default
Settings” box directly to the right. Then uncheck the “Automatic
Threshold” box: set the threshold to 25,000.

d. Click on target “IAC” and uncheck the “Ct Settings to Use: Default
Settings” box directly to the right. Then uncheck the “Automatic
Threshold” box: set the threshold to 5,000.

e. Click “Apply” in the bottom right corner.

7. Save File
a. Navigate to the “File” tab and choose “Save As”. Name the file

‘500003XMPExtractQS5v2’ and ensure it is saved as an *.edt file.
8. Run File

a. Select “File” then ”Open”.
b. Select your chosen *.edt file.
c. Navigate to the “Run” tab, and click the dropdown arrow next to

“Start Run”. Ensure the name of the instrument is your preferred
instrument. You will be prompted to enter a name for the run.

d. Insert the desired run name and click “Start Run”.
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Applied BiosystemsTM QuantStudioTM 5 Real-Time PCR System (0.2 mL 96-well) -
Thermocycling Programing

Pooling - Direct Pooled Patient Sample (40 μL reaction volume)

Please refer to the following steps for QuantStudioTM 5 Real-Time PCR System manual
programming specific for Direct Patient sample testing.

1. Open the QuantStudioTM Design and Analysis Software v1.5.1
2. Select the “Create New Experiment” option
3. Within the properties tab, select the following properties to filter:

a. Name: User defined or 500003XMPDirectPooledQS5Rev01.edt
b. Instrument Type: QuantStudioTM 5 Real-Time PCR System
c. Block Type: 96-Well 0.2 mL
d. Experiment type: Standard Curve
e. Chemistry: TaqMan Reagents
f. Run mode: Standard

4. Run Method (Method Tab)
a. Change the Reaction Volume to 40.0 μL
b. Temperature of the enabled heated cover will remain at 105.0 °C
c. Within the “PCR Stage “ section of the thermocycling parameters, an

additional step will need to be added by bringing the mouse pointer
above “Step 2” will allow the “+” and “-” buttons to become visible.

d. Click the “+” button to add “Step 3” to the “PCR Stage”.
e. Going back to the first hold stage enter the following parameters (Table

A3):
i. Hold Stage: Step 1

1. 1.6 ramp rate
2. 46°C
3. 20 minutes

ii. Hold Stage: Step 2
1. 1.6 ramp rate
2. 95°C
3. 5 minutes

iii. PCR Stage: Step 1
1. 1.6 ramp rate
2. 95°C
3. 3 seconds

iv. PCR Stage: Step 2
1. 1.6 ramp rate
2. 62°C
3. 20 seconds
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4. Scanning is turned ON by clicking the camera icon (dark blue
when ON).

v. PCR Stage: Step 3
1. 1.6 ramp rate
2. 70°C
3. 5 seconds
4. Scanning is turned OFF by clicking the camera icon (light
blue when OFF).

vi. Number of cycles set to 40 (located at the bottom of the “PCR Stage”
section).

Table A3. QuantStudioTM 5 thermocycling summary - Pooled Direct Patient Sample.

PCR Cycle Summary

Hold Stage PCR Stage

Conditions Step 1 Step 2 Step 1 Step 2 Step 3

Ramp Rate (°C/s) 1.6 1.6 1.6 1.6 1.6

Temperature (°C) 46 95 95 62 70

Duration (Min:sec) 20:00 5:00 0:03 0:20 0:05

Detection OFF OFF OFF ON OFF

No. of PCR Cycles 1 1 40

5. Plate Setup (Plate Tab)
a. Under the “Plate Attribute” section of the Quick Setup tab, change the

Passive Reference to “NONE”.
b. On the left side of the screen (next to Quick Setup), choose “Advanced

Setup”.
c. In the “Targets” section, click on the “Add” box and add two targets for a

total of three. Rename “Target 1” as “RNaseP”.
d. Click the associated reporter box below the Reporter tab and, from the

drop down menu, choose “FAM”.
e. Click on the “Target 2” box and change the name to “N1”.
f. Click the associated reporter box below the Reporter tab and, from the

drop down menu, choose “ROX”.
g. Click on the “Target 3” box and change the name to “IAC”.
h. Click the associated reporter box below the Reporter tab and, from the

drop down menu, choose “Cy5”
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i. Ensure that the “Quencher” tab for all three targets is set to “None”.
j. Highlight all the wells that you intend to use and ensure that the boxes

besides the three targets are selected and in the task select “U” for
unknown. This should populate the plate on the right side of the screen
with each target.

k. To name your wells by sample name, select the appropriate well on the
right side of the screen. Under the “Samples” tab on the left side, click on
the current sample name and rename to whatever is desired for the
experiment. Check the box besides the sample name: the names will
populate on the right side.

l. To add additional sample names, click “Add” on the samples tab and
repeat the instructions above.

m. Click on the “Results” tab on the top of the screen

6. Threshold Setup (Results Tab)
a. Navigate to the “Results” tab and select the settings wheel besides

“Analyze” in the upper right corner.
b. Click on target “N1” and uncheck the “Ct Settings to Use: Default

Settings” box directly to the right. Then uncheck the “Automatic
Threshold” box: set the threshold to 10,000.

c. Click on target “RNaseP” and uncheck the “Ct Settings to Use: Default
Settings” box directly to the right. Then uncheck the “Automatic
Threshold” box: set the threshold to 25,000.

d. Click on target “IAC” and uncheck the “Ct Settings to Use: Default
Settings” box directly to the right. Then uncheck the “Automatic
Threshold” box: set the threshold to 5,000.

e. Click “Apply” in the bottom right corner.
7. Save File

a. Navigate to the “File” tab and choose “Save As”. Name the file
‘500003XMPDirectPooledQS5Rev01’ and ensure it is saved as an *.edt
file.

8. Run File
a. Select “File” then ”Open”.
b. Select your chosen *.edt file.
c. Navigate to the “Run” tab, and click the dropdown arrow next to

“Start Run”. Ensure the name of the instrument is your preferred
instrument. You will be prompted to enter a name for the run.

d. Insert the desired run name and click “Start Run”.
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APPENDIX B

Applied BiosystemsTM QuantStudioTM 5 Real-Time PCR System (384-well) -
Thermocycling Programing

Direct Patient Sample (20 μL reaction volume)

Please refer to the following steps for QuantStudioTM 5 Real-Time PCR System
(384-well) manual programming specific for Direct Patient sample testing.

1. Open the QuantStudioTM Design and Analysis Software v1.5.1
2. Select the “Create New Experiment” option
3. Within the properties tab, select the following properties to filter:

1) Name: User defined or 500003XMPDirectQS5_384Rev01.edt
2) Instrument Type: QuantStudioTM 5, 384-well Real-Time PCR System
3) Block Type: 384-Well 0.2 mL
4) Experiment type: Standard Curve
5) Chemistry: TaqMan Reagents
6) Run mode: Standard

4. Run Method (Method Tab)
a. Change the Reaction Volume to 20.0 μL
b. Temperature of the enabled heated cover will remain at 105.0 °C
c. Within the “PCR Stage “ section of the thermocycling parameters, an additional

step will need to be added by bringing the mouse pointer above “Step 2” will
allow the “+” and “-” buttons to become visible.

d. Click the “+” button to add “Step 3” to the “PCR Stage”.
e. Going back to the first hold stage enter the following parameters (Table B1):

i. Hold Stage: Step 1
1. 1.6 ramp rate
2. 46°C
3. 20 minutes

ii. Hold Stage: Step 2
1. 1.6 ramp rate
2. 95°C
3. 5 minutes

iii. PCR Stage: Step 1
1. 1.6 ramp rate
2. 95°C
3. 3 seconds
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iv. PCR Stage: Step 2
1. 1.6 ramp rate
2. 62°C
3. 20 seconds
4. Scanning is turned ON by clicking the camera icon (dark blue
when ON).

v. PCR Stage: Step 3
1. 1.6 ramp rate
2. 70°C
3. 5 seconds
4. Scanning is turned OFF by clicking the camera icon (light
blue when OFF).

vi. Number of cycles set to 40 (located at the bottom of the “PCR Stage”
section).

Table B1. QuantStudioTM 5 (384-well) thermocycling summary - Direct Patient Sample.

PCR Cycle Summary

Hold Stage PCR Stage

Conditions Step 1 Step 2 Step 1 Step 2 Step 3

Ramp Rate (°C/s) 1.6 1.6 1.6 1.6 1.6

Temperature (°C) 46 95 95 62 70

Duration (Min:sec) 20:00 5:00 0:03 0:20 0:05

Detection OFF OFF OFF ON OFF

No. of PCR Cycles 1 1 40

5. Plate Setup (Plate Tab)
a. Under the “Plate Attribute” section of the Quick Setup tab, change the Passive

Reference to “NONE”.
b. On the left side of the screen (next to Quick Setup), choose “Advanced Setup”.
c. In the “Targets” section, click on the “Add” box and add two targets for a total of

three. Rename “Target 1” as “RNaseP”.
d. Click the associated reporter box below the Reporter tab and, from the drop

down menu, choose “FAM”.
e. Click on the “Target 2” box and change the name to “N1”.
f. Click the associated reporter box below the Reporter tab and, from the drop

down menu, choose “ROX”.
g. Click on the “Target 3” box and change the name to “IAC”.
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h. Click the associated reporter box below the Reporter tab and, from the drop
down menu, choose “Cy5”

i. Ensure that the “Quencher” tab for all three targets is set to “None”.
j. Highlight all the wells that you intend to use and ensure that the boxes besides

the three targets are selected and in the task select “U” for unknown. This should
populate the plate on the right side of the screen with each target.

k. To name your wells by sample name, select the appropriate well on the right side
of the screen. Under the “Samples” tab on the left side, click on the current
sample name and rename to whatever is desired for the experiment. Check the
box besides the sample name: the names will populate on the right side.

l. To add additional sample names, click “Add” on the samples tab and repeat the
instructions above.

m. Click on the “Results” tab on the top of the screen

6. Threshold Setup (Results Tab)
a. Navigate to the “Results” tab and select the settings wheel besides “Analyze” in

the upper right corner.
b. Click on target “N1” and uncheck the “Ct Settings to Use: Default Settings” box

directly to the right. Then uncheck the “Automatic Threshold” box: set the
threshold to 10,000.

c. Click on target “RNaseP” and uncheck the “Ct Settings to Use: Default Settings”
box directly to the right. Then uncheck the “Automatic Threshold” box: set the
threshold to 25,000.

d. Click on target “IAC” and uncheck the “Ct Settings to Use: Default Settings” box
directly to the right. Then uncheck the “Automatic Threshold” box: set the
threshold to 5,000.

e. Click “Apply” in the bottom right corner.

7. Save File
a. Navigate to the “File” tab and choose “Save As”. Name the file

‘500003XMPDirectQS5_384Rev01.edt’ and ensure it is saved as an *.edt file.

8. Run File
a. Select “File” then ”Open”.
b. Select your chosen *.edt file.
c. Navigate to the “Run” tab, and click the dropdown arrow next to

“Start Run”. Ensure the name of the instrument is your preferred
instrument. You will be prompted to enter a name for the run.

d. Insert the desired run name and click “Start Run”.
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Applied BiosystemsTM QuantStudioTM 5 Real-Time PCR System (384-well) -
Thermocycling Programing

Extracted Patient Sample (15 μL reaction volume)

Please refer to the following steps for QuantStudioTM 5 Real-Time PCR System
(384-well) manual programming specific for Extracted Patient sample testing.

1. Open the QuantStudioTM Design and Analysis Software v1.5.1

2. Select the “Create New Experiment” option

3. Within the properties tab, select the following properties to filter:
a. Name: User defined or 500003XMPExtractedQS5_384Rev01.edt
b. Instrument Type: QuantStudioTM 5 Real-Time PCR System , 384-well System
c. Block Type: 384-Well 0.2 mL
d. Experiment type: Standard Curve
e. Chemistry: TaqMan Reagents
f. Run mode: Standard

4. Run Method (Method Tab)
a. Change the Reaction Volume to 15.0 μL
b. Temperature of the enabled heated cover will remain at 105.0 °C
c. Within the “PCR Stage “ section of the thermocycling parameters, an additional

step will need to be added by bringing the mouse pointer above “Step 2” will
allow the “+” and “-” buttons to become visible.

d. Click the “+” button to add “Step 3” to the “PCR Stage”.
e. Going back to the first hold stage enter the following parameters (Table B2):

i. Hold Stage: Step 1
1. 1.6 ramp rate
2. 46°C
3. 20 minutes

ii. Hold Stage: Step 2
1. 1.6 ramp rate
2. 95°C
3. 5 minutes

iii. PCR Stage: Step 1
1. 1.6 ramp rate
2. 95°C
3. 3 seconds
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iv. PCR Stage: Step 2
1. 1.6 ramp rate
2. 62°C
3. 20 seconds
4. Scanning is turned ON by clicking the camera icon (dark blue
when ON).

v. PCR Stage: Step 3
1. 1.6 ramp rate
2. 70°C
3. 5 seconds
4. Scanning is turned OFF by clicking the camera icon (light
blue when OFF).

vi. Ensure the number of cycles is set to 40 (located at the bottom
border of the PCR Stage).

Table B2. QuantStudioTM 5 (384-well) thermocycling summary - Direct Patient Sample.

PCR Cycle Summary

Hold Stage PCR Stage

Conditions Step 1 Step 2 Step 1 Step 2 Step 3

Ramp Rate (°C/s) 1.6 1.6 1.6 1.6 1.6

Temperature (°C) 46 95 95 62 70

Duration (Min:sec) 20:00 5:00 0:03 0:20 0:05

Detection OFF OFF OFF ON OFF

No. of PCR Cycles 1 1 40

5. Plate Setup (Plate Tab)
a. Under the “Plate Attribute” section of the Quick Setup tab, change the Passive

Reference to “NONE”.
b. On the left side of the screen (next to Quick Setup), choose “Advanced Setup”.
c. In the “Targets” section, click on the “Add” box and add two targets for a total of

three. Rename “Target 1” as “RNaseP”.
d. Click the associated reporter box below the Reporter tab and, from the drop

down menu, choose “FAM”.
e. Click on the “Target 2” box and change the name to “N1”.
f. Click the associated reporter box below the Reporter tab and, from the drop

down menu, choose “ROX”.
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g. Click on the “Target 3” box and change the name to “IAC”.
h. Click the associated reporter box below the Reporter tab and, from the drop

down menu, choose “Cy5”
i. Ensure that the “Quencher” tab for all three targets is set to “None”.
j. Highlight all the wells that you intend to use and ensure that the boxes besides

the three targets are selected. In the “Task” section select “U” for unknown. This
should populate the plate on the right side of the screen with each target.

k. To name your wells by sample name, select the appropriate well on the right side
of the screen. Under the “Samples” tab on the left side, click on the current
sample name and rename to whatever is desired for the experiment. Check the
box besides the sample name: the names will populate on the right side.

l. To add additional sample names, click “Add” on the samples tab and repeat the
instructions above.

m. Click on the “Results” tab on the top of the screen

6. Threshold Setup (Results Tab)
a. Navigate to the “Results” tab and select the settings wheel besides “Analyze” in

the upper right corner.
b. Click on target “N1” and uncheck the “Ct Settings to Use: Default Settings” box

directly to the right. Then uncheck the “Automatic Threshold” box: set the
threshold to 10,000.

c. Click on target “RNaseP” and uncheck the “Ct Settings to Use: Default Settings”
box directly to the right. Then uncheck the “Automatic Threshold” box: set the
threshold to 25,000.

d. Click on target “IAC” and uncheck the “Ct Settings to Use: Default Settings” box
directly to the right. Then uncheck the “Automatic Threshold” box: set the
threshold to 5,000.

e. Click “Apply” in the bottom right corner.

7. Save File
a. Navigate to the “File” tab and choose “Save As”. Name the file

‘500003XMPExtractedQS5_384Rev01.edt’ and ensure it is saved as an *.edt file.

8. Run File
a. Select “File” then ”Open”.
b. Select your chosen *.edt file.
c. Navigate to the “Run” tab, and click the dropdown arrow next to

“Start Run”. Ensure the name of the instrument is your preferred
instrument. You will be prompted to enter a name for the run.

d. Insert the desired run name and click “Start Run”.
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APPENDIX C

Applied BiosystemsTM 7500 Fast Dx Real-Time PCR Instrument - Thermocycling
Programing

Direct Patient Sample (20 μL reaction volume)

Please refer to the following steps for Applied BiosystemsTM 7500 Fast Dx Real-Time PCR
Instrument manual programming specific for Direct Patient sample testing.

1. Open the Applied BiosystemsTM 7500 Fast Dx software v1.4.1
2. Go to the “Tools” tab and navigate to “Detector Manager”

a. Click on the “File” dropdown and select “New”.
b. Name the target as “N1”

i. Set the reporter dye to “ROX”
ii. Set the quencher dye to none

iii. Click Apply
c. Name the target as “RNaseP”

i. Set the reporter dye to “FAM”
ii. Set the quencher dye to “None”

iii. Click Apply
d. Name the target as “IAC”

i. Set the reporter dye to “Cy5”
ii. Set the quencher dye to “None”

iii. Click Apply
3. Click the “File” tab and select “New”
4. On the “Define document” Pop-Up:

a. Assay: Standard Curve (Absolute Quantification)
b. Container: 96 Well Clear
c. Template: Blank Document
d. Run Mode: Fast 7500
e. Operator: Select the operator you wish to run the assay with
f. Plate Name: Select your desired name for the experiment file
g. Click “Next”

5. Select the previously created detectors from the library: N1, RNaseP, IAC and
click add.

6. Set the Passive Reference to “None”
7. Click “next”. Select all the wells and assign the targets to them.
8. Select Finish.
9. Navigate to the Instrument tab.

a. Change the Sample Volume to 20.0 μL
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b. Click the “Add Hold” button until you have two hold steps. Set the
number of repetitions to 1.

c. Click the “Add Step” button until you have three PCR cycling steps. Set the
number of repetitions for this stage to 40.

d. Going back to the first hold stage enter, the following parameters (Table
C1):

i. Hold Stage: Step 1
1. Auto ramp rate
2. 46°C
3. 20 minutes

ii. Hold Stage: Step 2
1. Auto ramp rate
2. 95°C
3. 5 minutes

iii. PCR Stage: Step 1
1. Auto ramp rate
2. 95°C
3. 3 seconds

iv. PCR Stage: Step 2
1. Auto ramp rate
2. 62°C
3. 24 seconds.

v. PCR Stage: Step 3
1. Auto ramp rate
2. 70°C
3. 5 seconds

vi. Under settings, select the following:
1. Sample Volume: 20
2. Run Mode: Fast 7500
3. Data Calculation: Stage 3, step 2

e. Select the “Analysis” tab and click “Analysis settings”.
i. Select N1’s target settings by clicking on the detector dropdown.

1. Select “Manual CT” and set the threshold to 50,000
2. Select “Manual Baseline” and set the start cycle to 3 and

the end to 10.
3. Click apply

ii. Select RNaseP
1. Select Manual CT and set the threshold to 100,000
2. Select “Manual Baseline” and set the start cycle to 3 and

the end to 15
3. Click apply

iii. Select IAC
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1. Select Manual CT and set the threshold to 100,000
2. Select “Manual Baseline” and set the start cycle to 3 and

the end to 20
3. Click “Apply”, then select “OK”.

f. Select File -> Save. Set your desired name and your template is saved.

Table C1. Applied BiosystemsTM 7500 thermocycling summary - Direct Patient Sample.

PCR Cycle Summary

Hold Stage PCR Stage

Conditions Step 1 Step 2 Step 1 Step 2 Step 3

Ramp Rate (°C/s) Auto Auto Auto Auto Auto

Temperature (°C) 46 95 95 62 70

Duration (Min:sec) 20:00 5:00 0:03 0:24 0:05

Detection OFF OFF OFF ON OFF

No. of PCR Cycles 1 1 40
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Applied BiosystemsTM 7500 Fast Dx Real-Time PCR Instrument- Thermocycling
Programing

Extracted Patient Sample (15 μL reaction volume)

Please refer to the following steps for Applied BiosystemsTM 7500 Fast Dx Real-Time PCR
Instrument manual programming specific for Extracted patient sample testing.

1. Open the Applied BiosystemsTM 7500 Fast Dx software v1.4.1
2. Go to the “Tools” tab and navigate to “Detector Manager”

a. Click on the “File” dropdown and select “New”.
b. Name the target as “N1”

i. Set the reporter dye to “ROX”
ii. Set the quencher dye to none

iii. Click Apply
c. Name the target as “RNaseP”

i. Set the reporter dye to “FAM”
ii. Set the quencher dye to “None”

iii. Click Apply
d. Name the target as “IAC”

i. Set the reporter dye to “Cy5”
ii. Set the quencher dye to “None”

iii. Click Apply
3. Click the “File” tab and select “New”
4. On the “Define document” Pop-Up:

a. Assay: Standard Curve (Absolute Quantification)
b. Container: 96 Well Clear
c. Template: Blank Document
d. Run Mode: Fast 7500
e. Operator: Select the operator you wish to run the assay with
f. Plate Name: Select your desired name for the experiment file
g. Click “Next”

5. Select the previously created detectors from the library: N1, RNaseP, IAC and
click add.

6. Set the Passive Reference to “None”
7. Click “next”. Select all the wells and assign the targets to them.
8. Select Finish.
9. Navigate to the Instrument tab.

a. Change the Sample Volume to 15.0 μL
b. Click the “Add Hold” button until you have two hold steps. Set the

number of repetitions to 1.
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c. Click the “Add Step” button until you have three PCR cycling steps. Set the
number of repetitions for this stage to 40.

d. Going back to the first hold stage enter, the following parameters (Table
C2):

i. Hold Stage: Step 1
1. Auto ramp rate
2. 46°C
3. 20 minutes

ii. Hold Stage: Step 2
1. Auto ramp rate
2. 95°C
3. 5 minutes

iii. PCR Stage: Step 1
1. Auto ramp rate
2. 95°C
3. 3 seconds

iv. PCR Stage: Step 2
1. Auto ramp rate
2. 62°C
3. 24 seconds.

v. PCR Stage: Step 3
1. Auto ramp rate
2. 70°C
3. 5 seconds

vi. Under settings, select the following:
1. Sample Volume: 20
2. Run Mode: Fast 7500
3. Data Calculation: Stage 3, step 2

e. Select the “Analysis” tab and click “Analysis settings”.
i. Select N1’s target settings by clicking on the detector dropdown.

1. Select “Manual CT” and set the threshold to 50,000
2. Select “Manual Baseline” and set the start cycle to 3 and

the end to 10.
3. Click apply

ii. Select RNaseP
1. Select Manual CT and set the threshold to 100,000
2. Select “Manual Baseline” and set the start cycle to 3 and

the end to 15
3. Click apply

iii. Select IAC
1. Select Manual CT and set the threshold to 100,000
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2. Select “Manual Baseline” and set the start cycle to 3 and
the end to 20

3. Click “Apply”, then select “OK”.
f. Select File -> Save. Set your desired name and your template is saved.

Table C2. Applied BiosystemsTM 7500 thermocycling summary - Extracted Patient
Sample.

PCR Cycle Summary

Hold Stage PCR Stage

Conditions Step 1 Step 2 Step 1 Step 2 Step 3

Ramp Rate (°C/s) Auto Auto Auto Auto Auto

Temperature (°C) 46 95 95 62 70

Duration (Min:sec) 20:00 5:00 0:03 0:24 0:05

Detection OFF OFF OFF ON OFF

No. of PCR Cycles 1 1 40
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Applied BiosystemsTM 7500 Fast Dx Real-Time PCR Instrument - Thermocycling
Programing

Pooled Direct Patient Sample (40 μL reaction volume)

Please refer to the following steps for Applied BiosystemsTM 7500 Fast Dx Real-Time PCR
Instrument manual programming specific for Direct Patient sample testing.

1. Open the Applied BiosystemsTM 7500 Fast Dx software v1.4.1
2. Go to the “Tools” tab and navigate to “Detector Manager”

a. Click on the “File” dropdown and select “New”.
b. Name the target as “N1”

i. Set the reporter dye to “ROX”
ii. Set the quencher dye to none
iii. Click Apply

c. Name the target as “RNaseP”
i.Set the reporter dye to “FAM”

ii.Set the quencher dye to “None”
iii.Click Apply

d. Name the target as “IAC”
i. Set the reporter dye to “Cy5”
ii. Set the quencher dye to “None”
iii. Click Apply

3. Click the “File” tab and select “New”
4. On the “Define document” Pop-Up:

a. Assay: Standard Curve (Absolute Quantification)
b. Container: 96 Well Clear
c. Template: Blank Document
d. Run Mode: Fast 7500
e. Operator: Select the operator you wish to run the assay with
f. Plate Name: Select your desired name for the experiment file
g. Click “Next”

5. Select the previously created detectors from the library: N1, RNaseP, IAC and click
add.
6. Set the Passive Reference to “None”
7. Click “next”. Select all the wells and assign the targets to them.
8. Select Finish.
9. Navigate to the Instrument tab.

a. Change the Sample Volume to 40.0 μL
b. Click the “Add Hold” button until you have two hold steps. Set the

number of repetitions to 1.
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c. Click the “Add Step” button until you have three PCR cycling steps.
Set the number of repetitions for this stage to 40.

d. Going back to the first hold stage enter, the following parameters
(Table C3):

i. Hold Stage: Step 1
1. Auto ramp rate
2. 46°C
3. 20 minutes
ii. Hold Stage: Step 2
4. Auto ramp rate
5. 95°C
6. 5 minutes
iii. PCR Stage: Step 1
7. Auto ramp rate
8. 95°C
9. 3 seconds

iv. PCR Stage: Step 2
1. Auto ramp rate
2. 62°C
3. 24 seconds.

v. PCR Stage: Step 3
1. Auto ramp rate
2. 70°C
3. 5 seconds

vi. Under settings, select the following:
1. Sample Volume: 40
2. Run Mode: Fast 7500
3. Data Calculation: Stage 3, step 2

e. Select the “Analysis” tab and click “Analysis settings”.
vii. Select N1’s target settings by clicking on the detector dropdown.

1. Select “Manual CT” and set the threshold to 50,000
2. Select “Manual Baseline” and set the start cycle to 3 and

the end to 10.
3. Click apply

viii. Select RNaseP
1. Select Manual CT and set the threshold to 100,000
2. Select “Manual Baseline” and set the start cycle to 3 and

the end to 15
3. Click apply

ix. Select IAC
1. Select Manual CT and set the threshold to 100,000
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2. Select “Manual Baseline” and set the start cycle to 3 and
the end to 20

3. Click “Apply”, then select “OK”.
g. Select File -> Save. Set your desired name and your template is saved.

Table C3. Applied BiosystemsTM 7500 thermocycling summary - Pooled Direct Patient
Sample.

PCR Cycle Summary

Hold Stage PCR Stage

Conditions Step 1 Step 2 Step 1 Step 2 Step 3

Ramp Rate (°C/s) Auto Auto Auto Auto Auto

Temperature (°C) 46 95 95 62 70

Duration (Min:sec) 20:00 5:00 0:03 0:24 0:05

Detection OFF OFF OFF ON OFF

No. of PCR Cycles 1 1 40
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APPENDIX D

Bio-Rad CFX96 TouchTM Real-Time PCR Detection System - Thermocycling Programing

Direct Patient Sample (20 μL reaction volume)

Please refer to the following steps for Bio-Rad CFX96 TouchTM Real-Time PCR Detection
System manual programming specific for Direct Patient sample testing.

1. Launch the CFX MaestroTM software.

2. Select “File”, then choose “New” and select “Protocol”

3. Program thermocycling conditions in the Protocol Editor
a. Set Sample Volume to 20 μL
b. Click “Insert Step” to add a total of five total steps and program as follows
(Table D1):
c. Step 1

i. Temp: 46°C
ii. Time: 20:00

d. Step 2
i. Temp: 95°C
ii. Time: 5:00

e. Step 3
i. Temp: 95°C
ii. Time: 0:03

f. Step 4
i. Temp: 62°C
ii. Time: 0:20
iii. Click “Add Plate Read to Step”. Also, ensure this is the only step
containing a plate read

g. Step 5
i. Temp: 70°C
ii. Time: 0:05

h. Step 6
i. Click to highlight “GOTO” and enter “3” to indicate thermocycling
includes Step 3, Step 4 and Step 5.
ii. At “GOTO 3”, confirm “39 more times” is programmed for a total of 40
cycles.

I. Save the new cycling conditions as protocol for future use
i. At the upper left of the screen select the Save button
ii. Save in the ExpressLoad folder
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iii. Name the file ‘500003XMPDirectCFX96v2’
iv. Save as type ‘Protocol File (*.prcl)’
v. Select Save
vi. Click Ok in the protocol editor window

Table D1. CFX96 TouchTM thermocycling summary - Direct Patient Sample.

PCR Cycle Summary

Hold Stage PCR Stage

Conditions Step 1 Step 2 Step 1 Step 2 Step 3

Temperature (°C) 46 95 95 62 70

Duration (Min:sec) 20:00 5:00 0:03 0:20 0:05

Detection OFF OFF OFF ON OFF

No. of PCR Cycles 1 1 40

4. Define the plate setup
a. Select “File” then choose “New” and select “Plate”
b. In the Plate Editor, click settings and ensure your settings are as follows

i. Plate Size: 96 wells
ii. Plate Type: BR White

c. Highlight all wells and choose “Select Fluorophores”
i. Uncheck all currently selected wells and check ONLY the following: FAM,
Cal Red 610, Quasar 670

d. For “Sample Type” select “Unknown”
e. Check the boxes besides all three of your selected fluorophores. Change the

target name as follows:
i. FAM: RNaseP
ii. Cal Red 610: N1
iii. Quasar 670: IAC

f. Save the new plate setup for future use
i. At the upper left of the screen select ”File” then select “Save”
iii. Name the file ‘500003XMPDirect_plateCFX96v2’
iv. Save as type ‘Plate File (*.pltd)’
v. Select Save
vi. Click Ok in the Plate Editor window

g. Saving Protocol
i. Select “File” then “Open”
ii. Select “Protocol” then open your saved protocol.
ii. Ensure the PCR steps are correct and click “OK”
iii. Click the “Plate” tab and choose “Select Existing”. Choose the
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plate that was saved.
iv. Add any desired notes and click on the “Start Run” tab.
v. Save the run with the desired name

h. Assigning a sample name to well positions
Once the run has begun, reaction wells can be assigned with a unique

sample name as follows:

i. Navigate to “Real Time Status”

ii. On the top-middle section of the screen, click “Plate Set-Up”

followed by “View/Edit Plate”.

iii.Click “Spreadsheet View/Importer” on the upper right quadrant of

the screen. Wells can be named with unique identifiers for

Sample Name, Sample Type, etc.

5. When CFX96 TouchTM run is completed, threshold setting update will need to be
completed as follows:

a. Open the “Data Analysis” window for your specific run
b. To apply threshold settings for FAM-channel, uncheck CalRed 610-channel

and Quasar 670-channel and be sure “FAM” is checked (Note: Threshold
adjustments can be performed only in single threshold mode, be sure
only one dye is selected)
i.Navigate to “Settings” and select “Baseline Threshold”
ii.At the bottom of the popup window under “single threshold”, select

“User Defined” and enter “500”
iii.Click “OK” and the threshold for FAM will apply to the experiment.

c. To apply threshold settings for CalRed 610-channel, uncheck FAM-channel
and Quasar 670-channel and be sure “CalRed 610” is checked (Note:
Threshold adjustments can be performed only in single threshold mode,
be sure only one dye is selected)
i.Navigate to “Settings” and select “Baseline Threshold”
ii.At the bottom of the popup window under “single threshold”, select

“User Defined” and enter “500”
iii.Click “OK” and the threshold for CalRed 610 will apply to the

experiment
d. To apply threshold settings for Quasar 670-channel, uncheck

FAM-channel and CalRed 610-channel and be sure “Quasar 670” is
checked (Note: Threshold adjustments can be performed only in single
threshold mode, be sure only one dye is selected)
i.Navigate to “Settings” and select “Baseline Threshold”
ii.At the bottom of the popup window under “single threshold”, select

“User Defined” and enter “500”
iii.Click “OK” and the threshold for Quasar 670 will apply to the

experiment
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Bio-Rad CFX96 TouchTM Real-Time PCR Detection System - Thermocycling Programing

Extracted Patient Sample (15 μL reaction volume)

Please refer to the following steps for Bio-Rad CFX96 TouchTM Real-Time PCR Detection
System manual programming specific for Extracted Patient sample testing.

1. Launch the CFX Maestro software.

2. Choose “File”, then choose “New” and select “Protocol”

3. Program thermocycling conditions in the Protocol Editor
a. Set Sample Volume to 15 μL
b. Click “Insert Step” to add a total of five total steps and program as follows
(Table D2):
c. Step 1

i. Temp: 46°C
ii. Time: 20:00

d. Step 2
i. Temp: 95°C
ii. Time: 5:00

e. Step 3
i. Temp: 95°C
ii. Time: 0:03

f. Step 4
i. Temp: 62°C
ii. Time: 0:20
iii. Click “Add Plate Read to Step”. Also, ensure this is the only step
containing a plate read

g. Step 5
i. Temp: 70°C
ii. Time: 0:05

h. Step 6
i. Click to highlight “GOTO” and enter “3” to indicate thermocycling
includes Step 3, Step 4 and Step 5.
ii. At “GOTO 3”, confirm “39 more times” is programmed for a total of 40
cycles.

i. Save the new cycling conditions as a protocol for future use
i. At the upper left of the screen select the Save button
ii. Save in the ExpressLoad folder
iii. Name the file ‘500003XMPExtractCFX96v2’
iv. Save as type ‘Protocol File (*.prcl)’
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v. Select Save
vi. Click Ok in the protocol editor window

Table D2. CFX96 TouchTM thermocycling summary - Extracted Patient Sample.

PCR Cycle Summary

Hold Stage PCR Stage

Conditions Step 1 Step 2 Step 1 Step 2 Step 3

Temperature (°C) 46 95 95 62 70

Duration (Min:sec) 20:00 5:00 0:03 0:20 0:05

Detection OFF OFF OFF ON OFF

No. of PCR Cycles 1 1 40

4. Define the plate setup
a. Select “File” then choose “New” and select “Plate”
b. In the Plate Editor, click settings and ensure your settings are as follows

i. Plate Size: 96 wells
ii. Plate Type: BR White

c. Highlight all wells and choose “Select Fluorophores”
i. Uncheck all currently selected wells and check ONLY the following: FAM,
Cal Red 610, Quasar 670

d. For “Sample Type” select “Unknown”
e. Check the boxes besides all three of your selected fluorophores. Change the

target name as follows:
i. FAM: RNaseP
ii. CalRed 610: N1
iii.: Quasar 670: IAC

f. Save the new plate setup for future use
i. At the upper left of the screen select ”File” then select “Save”
iii. Name the file “500003XMPExtract_plateCFX96v2”.
iv. Ensure it is saved in the “*.pltd” format
v. Select Save
vi. Click Ok in the Plate Editor window

g. Saving Protocol
i. Select “File” then “Open”
ii. Select “Protocol” then open your saved protocol.
ii. Ensure the PCR steps are correct and click “OK”
iii. Click the “Plate” tab and choose “Select Existing”. Choose the
plate that was saved.
iv. Add any desired notes and click on the “Start Run” tab.
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v. Save the run with the desired name
h. Assigning a sample name to well positions

Once the run has begun, reaction wells can be assigned with a unique

sample name as follows:

i. Navigate to “Real Time Status”

ii. On the top-middle section of the screen, click “Plate Set-Up”

followed by “View/Edit Plate”.

iii.Click “Spreadsheet View/Importer” on the upper right quadrant of

the screen. Wells can be named with unique identifiers for

Sample Name, Sample Type, etc.

5. When CFX96 TouchTM run is completed, threshold setting update will need to be
completed as follows:

a. Open the “Data Analysis” window for your specific run
b. To apply threshold settings for FAM-channel, uncheck CalRed 610-channel

and Quasar 670-channel and be sure “FAM” is checked (Note: Threshold
adjustments can be performed only in single threshold mode, be sure
only one dye is selected)
i.Navigate to “Settings” and select “Baseline Threshold”
ii.At the bottom of the popup window under “single threshold”, select

“User Defined” and enter “500”
iii.Click “OK” and the threshold for FAM will apply to the experiment.

c. To apply threshold settings for CalRed 610-channel, uncheck FAM-channel
and Quasar 670-channel and be sure “CalRed 610” is checked (Note:
Threshold adjustments can be performed only in single threshold mode,
be sure only one dye is selected)
i.Navigate to “Settings” and select “Baseline Threshold”
ii.At the bottom of the popup window under “single threshold”, select

“User Defined” and enter “500”
iii.Click “OK” and the threshold for CalRed 610 will apply to the

experiment
d. To apply threshold settings for Quasar 670-channel, uncheck

FAM-channel and CalRed 610-channel and be sure “Quasar 670” is
checked (Note: Threshold adjustments can be performed only in single
threshold mode, be sure only one dye is selected)
i.Navigate to “Settings” and select “Baseline Threshold”
ii.At the bottom of the popup window under “single threshold”, select

“User Defined” and enter “500”
iii.Click “OK” and the threshold for Quasar 670 will apply to the

experiment
6. Refer to Table 2 for result interpretation.

Page 97 of 121 500-003-XMP (CE-IVD) Rev. 09-07APR2023



COVID-19 Direct RT-PCR
Extraction-Free Multiplatform

Bio-Rad CFX96 TouchTM Real-Time PCR Detection System - Thermocycling Programing

Pooling - Direct Pooled Patient Sample (40 μL reaction volume)

Please refer to the following steps for Bio-Rad CFX96 TouchTM Real-Time PCR Detection
System manual programming specific for Direct Patient sample testing.

1. Launch the CFX MaestroTM software.

2. Select “File”, then choose “New” and select “Protocol”

3. Program thermocycling conditions in the Protocol Editor
a. Set Sample Volume to 40 μL
b. Click “Insert Step” to add a total of five total steps and program as follows
(Table D3):
c. Step 1

i. Temp: 46°C
ii. Time: 20:00

d. Step 2
i. Temp: 95°C
ii. Time: 5:00

e. Step 3
i. Temp: 95°C
ii. Time: 0:03

f. Step 4
i. Temp: 62°C
ii. Time: 0:20
iii. Click “Add Plate Read to Step”. Also, ensure this is the only step
containing a plate read

g. Step 5
i. Temp: 70°C
ii. Time: 0:05

h. Step 6
i. Click to highlight “GOTO” and enter “3” to indicate thermocycling
includes Step 3, Step 4 and Step 5.
ii. At “GOTO 3”, confirm “39 more times” is programmed for a total of 40
cycles.

I. Save the new cycling conditions as protocol for future use
i. At the upper left of the screen select the Save button
ii. Save in the ExpressLoad folder
iii. Name the file ‘500003XMPDirectPooledCFX96Rev01’
iv. Save as type ‘Protocol File (*.prcl)’
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v. Select Save
vi. Click Ok in the protocol editor window

Table D3. CFX96 TouchTM thermocycling summary - Pooled Direct Patient Sample.

PCR Cycle Summary

Hold Stage PCR Stage

Conditions Step 1 Step 2 Step 1 Step 2 Step 3

Temperature (°C) 46 95 95 62 70

Duration (Min:sec) 20:00 5:00 0:03 0:20 0:05

Detection OFF OFF OFF ON OFF

No. of PCR Cycles 1 1 40

4. Define the plate setup
a. Select “File” then choose “New” and select “Plate”
b. In the Plate Editor, click settings and ensure your settings are as follows

i. Plate Size: 96 wells
ii. Plate Type: BR White

c. Highlight all wells and choose “Select Fluorophores”
i. Uncheck all currently selected wells and check ONLY the following: FAM,
Cal Red 610, Quasar 670

d. For “Sample Type” select “Unknown”
e. Check the boxes besides all three of your selected fluorophores. Change the

target name as follows:
i. FAM: RNaseP
ii. Cal Red 610: N1
iii. Quasar 670: IAC

f. Save the new plate setup for future use
i. At the upper left of the screen select ”File” then select “Save”
iii. Name the file ‘500003XMPDirectPooledCFX96PlateRev01’
iv. Save as type ‘Plate File (*.pltd)’
v. Select Save
vi. Click Ok in the Plate Editor window

g. Saving Protocol
i. Select “File” then “Open”
ii. Select “Protocol” then open your saved protocol.
ii. Ensure the PCR steps are correct and click “OK”
iii. Click the “Plate” tab and choose “Select Existing”. Choose the
plate that was saved.
iv. Add any desired notes and click on the “Start Run” tab.
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v. Save the run with the desired name
h. Assigning a sample name to well positions

Once the run has begun, reaction wells can be assigned with a unique

sample name as follows:

i. Navigate to “Real Time Status”

ii. On the top-middle section of the screen, click “Plate Set-Up”

followed by “View/Edit Plate”.

iii.Click “Spreadsheet View/Importer” on the upper right quadrant of

the screen. Wells can be named with unique identifiers for

Sample Name, Sample Type, etc.

5. When CFX96 TouchTM run is completed, threshold setting update will need to be
completed as follows:

a. Open the “Data Analysis” window for your specific run
b. To apply threshold settings for FAM-channel, uncheck CalRed 610-channel

and Quasar 670-channel and be sure “FAM” is checked (Note: Threshold
adjustments can be performed only in single threshold mode, be sure
only one dye is selected)
i.Navigate to “Settings” and select “Baseline Threshold”
ii.At the bottom of the popup window under “single threshold”, select

“User Defined” and enter “500”
iii.Click “OK” and the threshold for FAM will apply to the experiment.

d. To apply threshold settings for CalRed 610-channel, uncheck FAM-channel
and Quasar 670-channel and be sure “CalRed 610” is checked (Note:
Threshold adjustments can be performed only in single threshold mode,
be sure only one dye is selected)
i.Navigate to “Settings” and select “Baseline Threshold”
ii.At the bottom of the popup window under “single threshold”, select

“User Defined” and enter “500”
iii.Click “OK” and the threshold for CalRed 610 will apply to the

experiment
e. To apply threshold settings for Quasar 670-channel, uncheck

FAM-channel and CalRed 610-channel and be sure “Quasar 670” is
checked (Note: Threshold adjustments can be performed only in single
threshold mode, be sure only one dye is selected)
i.Navigate to “Settings” and select “Baseline Threshold”
ii.At the bottom of the popup window under “single threshold”, select

“User Defined” and enter “500”
iii.Click “OK” and the threshold for Quasar 670 will apply to the

experiment
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APPENDIX E

Bio-Rad CFX384 TouchTM Real-Time PCR Detection System - Thermocycling Programing

Direct Patient Sample (20 μL reaction volume)

Please refer to the following steps for Bio-Rad CFX384 TouchTM Real-Time PCR Detection
System manual programming specific for Direct Patient sample testing.

1. Launch the CFX Maestro software.

2. Select “File”, then choose “New” and select “Protocol”

3. Program thermocycling conditions in the Protocol Editor
a. Set Sample Volume to 20 μL
b. Click “Insert Step” to add a total of five total steps and program as follows
(Table E1):
c. Step 1

i. Temp: 46°C
ii. Time: 20:00

d. Step 2
i. Temp: 95°C
ii. Time: 5:00

e. Step 3
i. Temp: 95°C
ii. Time: 0:03

f. Step 4
i. Temp: 62°C
ii. Time: 0:20
iii. Click “Add Plate Read to Step”. Also, ensure this is the only step
containing a plate read

g. Step 5
i. Temp: 70°C
ii. Time: 0:05

h. Step 6
i. Click to highlight “GOTO” and enter “3” to indicate thermocycling
includes Step 3, Step 4 and Step 5.
ii. At “GOTO 3”, confirm “39 more times” is programmed for a total of 40
cycles.

I. Save the new cycling conditions as protocol for future use
i. At the upper left of the screen select the Save button
ii. Save in the ExpressLoad folder
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iii. Name the file ‘500003XMPDirectCFX384’
iv. Save as type ‘Protocol File (*.prcl)’
v. Select Save
vi. Click Ok in the protocol editor window

Table E1. CFX384 TouchTM thermocycling summary - Direct Patient Sample.

PCR Cycle Summary

Hold Stage PCR Stage

Conditions Step 1 Step 2 Step 1 Step 2 Step 3

Temperature (°C) 46 95 95 62 70

Duration (Min:sec) 20:00 5:00 0:03 0:20 0:05

Detection OFF OFF OFF ON OFF

No. of PCR Cycles 1 1 40

4. Define the plate setup
a. Select “File” then choose “New” and select “Plate”
b. In the Plate Editor, click settings and ensure your settings are as follows

i. Plate Size: 384 well
ii. Plate Type: BR White

c. Highlight all wells and choose “Select Fluorophores”
i. Uncheck all currently selected wells and check ONLY the following: FAM,
Cal Red 610, Quasar 670

d. For “Sample Type” select “Unknown”
e. Check the boxes besides all three of your selected fluorophores. Change the

target name as follows:
i. FAM: RNaseP
ii. Cal Red 610: N1
iii. Quasar 670: IAC

f. Save the new plate setup for future use
i. At the upper left of the screen select ”File” then select “Save”
iii. Name the file ‘500003XMPDirect_plateCFX384’
iv. Save as type ‘Plate File (*.pltd)’
v. Select Save
vi. Click Ok in the Plate Editor window

g. Saving Protocol
i. Select “File” then “Open”
ii. Select “Protocol” then open your saved protocol.
ii. Ensure the PCR steps are correct and click “OK”
iii. Click the “Plate” tab and choose “Select Existing”. Choose the
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plate that was saved.
iv. Add any desired notes and click on the “Start Run” tab.
v. Save the run with the desired name

h. Assigning a sample name to well positions
Once the run has begun, reaction wells can be assigned with a unique

sample name as follows:

i. Navigate to “Real Time Status”

ii. On the top-middle section of the screen, click “Plate Set-Up”

followed by “View/Edit Plate”.

iii.Click “Spreadsheet View/Importer” on the upper right quadrant of

the screen. Wells can be named with unique identifiers for

Sample Name, Sample Type, etc.

5. When CFX384 TouchTM run is completed, threshold setting update will need to be
completed as follows:

a. Open the “Data Analysis” window for your specific run
b. To apply threshold settings for FAM-channel, uncheck CalRed 610-channel

and Quasar 670-channel and be sure “FAM” is checked (Note: Threshold
adjustments can be performed only in single threshold mode, be sure
only one dye is selected)
i.Navigate to “Settings” and select “Baseline Threshold”
ii.At the bottom of the popup window under “single threshold”, select

“User Defined” and enter “500”
iii.Click “OK” and the threshold for FAM will apply to the experiment.

e. To apply threshold settings for CalRed 610-channel, uncheck FAM-channel
and Quasar 670-channel and be sure “CalRed 610” is checked (Note:
Threshold adjustments can be performed only in single threshold mode,
be sure only one dye is selected)
i.Navigate to “Settings” and select “Baseline Threshold”
ii.At the bottom of the popup window under “single threshold”, select

“User Defined” and enter “250”
iii.Click “OK” and the threshold for CalRed 610 will apply to the

experiment
f. To apply threshold settings for Quasar 670-channel, uncheck

FAM-channel and CalRed 610-channel and be sure “Quasar 670” is
checked (Note: Threshold adjustments can be performed only in single
threshold mode, be sure only one dye is selected)
i.Navigate to “Settings” and select “Baseline Threshold”
ii.At the bottom of the popup window under “single threshold”, select

“User Defined” and enter “500”
iii.Click “OK” and the threshold for Quasar 670 will apply to the

experiment
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Bio-Rad CFX384 TouchTM Real-Time PCR Detection System - Thermocycling Programing

Extracted Patient Sample (15 μL reaction volume)

Please refer to the following steps for Bio-Rad CFX384 TouchTM Real-Time PCR Detection
System manual programming specific for Extracted Patient sample testing.

1. Launch the CFX Maestro software.

2. Choose “File”, then choose “New” and select “Protocol”

3. Program thermocycling conditions in the Protocol Editor
a. Set Sample Volume to 15 μL
b. Click “Insert Step” to add a total of five total steps and program as follows
(Table E2):
c. Step 1

i. Temp: 46°C
ii. Time: 20:00

d. Step 2
i. Temp: 95°C
ii. Time: 5:00

e. Step 3
i. Temp: 95°C
ii. Time: 0:03

f. Step 4
i. Temp: 62°C
ii. Time: 0:20
iii. Click “Add Plate Read to Step”. Also, ensure this is the only step
containing a plate read

g. Step 5
i. Temp: 70°C
ii. Time: 0:05

h. Step 6
i. Click to highlight “GOTO” and enter “3” to indicate thermocycling
includes Step 3, Step 4 and Step 5.
ii. At “GOTO 3”, confirm “39 more times” is programmed for a total of 40
cycles.

i. Save the new cycling conditions as a protocol for future use
i. At the upper left of the screen select the Save button
ii. Save in the ExpressLoad folder
iii. Name the file ‘500003XMPExtractCFX384’
iv. Save as type ‘Protocol File (*.prcl)’
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v. Select Save
vi. Click Ok in the protocol editor window

Table E2. CFX384 TouchTM thermocycling summary - Extracted Patient Sample.

PCR Cycle Summary

Hold Stage PCR Stage

Conditions Step 1 Step 2 Step 1 Step 2 Step 3

Temperature (°C) 46 95 95 62 70

Duration (Min:sec) 20:00 5:00 0:03 0:20 0:05

Detection OFF OFF OFF ON OFF

No. of PCR Cycles 1 1 40

4. Define the plate setup
a. Select “File” then choose “New” and select “Plate”
b. In the Plate Editor, click settings and ensure your settings are as follows

i. Plate Size: 384 well
ii. Plate Type: BR White

c. Highlight all wells and choose “Select Fluorophores”
i. Uncheck all currently selected wells and check ONLY the following: FAM,
Cal Red 610, Quasar 670

d. For “Sample Type” select “Unknown”
e. Check the boxes besides all three of your selected fluorophores. Change the

target name as follows:
i. FAM: RNaseP
ii. CalRed 610: N1
iii.: Quasar 670: IAC

f. Save the new plate setup for future use
i. At the upper left of the screen select ”File” then select “Save”
iii. Name the file “500003XMPExtract_plateCFX384”.
iv. Ensure it is saved in the “*.pltd” format
v. Select Save
vi. Click Ok in the Plate Editor window

g. Saving Protocol
i. Select “File” then “Open”
ii. Select “Protocol” then open your saved protocol.
ii. Ensure the PCR steps are correct and click “OK”
iii. Click the “Plate” tab and choose “Select Existing”. Choose the
plate that was saved.
iv. Add any desired notes and click on the “Start Run” tab.
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v. Save the run with the desired name
h. Assigning a sample name to well positions

Once the run has begun, reaction wells can be assigned with a unique

sample name as follows:

i. Navigate to “Real Time Status”

ii. On the top-middle section of the screen, click “Plate Set-Up”

followed by “View/Edit Plate”.

iii.Click “Spreadsheet View/Importer” on the upper right quadrant of

the screen. Wells can be named with unique identifiers for

Sample Name, Sample Type, etc.

5. When CFX384 TouchTM run is completed, threshold setting update will need to be
completed as follows:

a. Open the “Data Analysis” window for your specific run
b. To apply threshold settings for FAM-channel, uncheck CalRed 610-channel

and Quasar 670-channel and be sure “FAM” is checked (Note: Threshold
adjustments can be performed only in single threshold mode, be sure
only one dye is selected)
i.Navigate to “Settings” and select “Baseline Threshold”
ii.At the bottom of the popup window under “single threshold”, select

“User Defined” and enter “500”
iii.Click “OK” and the threshold for FAM will apply to the experiment.

d. To apply threshold settings for CalRed 610-channel, uncheck FAM-channel
and Quasar 670-channel and be sure “CalRed 610” is checked (Note:
Threshold adjustments can be performed only in single threshold mode,
be sure only one dye is selected)
i.Navigate to “Settings” and select “Baseline Threshold”
ii.At the bottom of the popup window under “single threshold”, select

“User Defined” and enter “250”
iii.Click “OK” and the threshold for CalRed 610 will apply to the

experiment
e. To apply threshold settings for Quasar 670-channel, uncheck

FAM-channel and CalRed 610-channel and be sure “Quasar 670” is
checked (Note: Threshold adjustments can be performed only in single
threshold mode, be sure only one dye is selected)
i.Navigate to “Settings” and select “Baseline Threshold”
ii.At the bottom of the popup window under “single threshold”, select

“User Defined” and enter “500”
iii.Click “OK” and the threshold for Quasar 670 will apply to the

experiment
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APPENDIX F

pixlTM Real-Time PCR Platform - Thermocycling Programing

Direct Patient Sample (20 μL reaction volume)

Please refer to the following steps for pixlTM Real-Time PCR Platform touchpad manual

programming specific for Direct patient sample testing.

1. Open the “BioGX qPCR” pixlTM Real-Time PCR Platform software

2. Select “Test” on the left side home screen

3. Within the “Test” screen, tap “New Experiment” to proceed to the Sample Setup screen

4. In the Experiment Name section, enter the test name.
a. Experiment Name: User-defined or 500003XMPDirExtpixlRev01

5. In the Channel section, select the dye and define the target identified in each channel.

a. Select Channel 1

i. From the drop-down menu select: FAM

ii. Name the Channel: RNaseP

b. Select Channel 3

i. From the drop-down menu select: ROX

ii. Name the Channel: CoV2-N1

c. Select Channel 4

i. From the drop-down menu select: Cy5

ii. Name the Channel: IAC

d. Integration Time for pixlTM Real-Time PCR Platform optimized tests are
recommended to remain set to: auto.

e. To name the wells by sample name, select the appropriate well and next to
“Name” rename well to whatever is desired for the experiment.

f. If necessary, a barcode scanner can be plugged into the USB port located
on the front panel of the instrument to facilitate sample ID capture.

6. Tap Next to go to the Cycling Program screen

7. Add, remove, or edit a stage or step.

8. Adjust the temperature and time of a stage of step, number of cycles, and data
capture step.

a. Ensure Auto Integration Time is selected

b. Within the section of the thermocycling parameters, an additional step will need

to be added by selecting the “+” next to “Const-tempe Stage”.

c. Starting at the first “Pre-Denat” stage enter the following parameters (Table F1)
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i. Pre-Denat: Step 1

1. 46°C

2. 600 seconds

ii. Pre-Denat2: Step 1

1. 95°C

2. 150 seconds

iii. Cycle Period: Step 1

1. 95°C

2. 5 seconds

iv. Cycle Period: Step 2

1. 59°C

2. 12 seconds

v. Hold: Step 1

1. 50°C

2. 60 seconds

d. Save the template file before starting the run by clicking “Save Template” in the

upper right corner.

Table F1: pixlTM Real-Time PCR Platform thermocycling summary: Direct Patient

Samples.

PCR Cycle Summary

Pre-Denat Stage Cycle Period Stage Hold Stage

Conditions Step 1 Step 2 Step 1 Step 2 Step 1

Temperature (°C) 46 95 95 59 50

Duration (sec) 600 150 5 12 60

Image Step No No No Yes No

No. of PCR Cycles 1 1 40 1
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9. Start Run

a. Select Start in the bottom right corner of the touchpad, this will

automatically take you to the “Run” tab

10. After run completion, navigate to the “Results” tab and select the appropriate

test to set the threshold for each channel used

a. Set Ct Low Limit to 13

b. Set Ct Threshold (%) to 6.0

11. Save File (Report tab)

a. In the upper right corner, select “Export” to save .json file, name file as

desired or “500003XMPDirExtpixlRev01”

b. Insert a USB key in the USB port located on the front panel of the

instrument to save the results file

c. Select “CSV” to save the file as an excel document

d. Select “PDF” to save the file as a PDF document

12. Select “JSON” to save the file as a JSON document
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pixlTM Real-Time PCR Platform - Thermocycling Programing

Extracted Patient Sample (15 μL reaction volume)

Please refer to the following steps for pixlTM Real-Time PCR Platform touchpad manual

programming specific for Extracted patient sample testing.

1. Open the “BioGX qPCR” pixlTM Real-Time PCR Platform app

2. Select “Test” on the left side home screen

3. Within the “Test” screen, tap “New Experiment” to proceed to the Sample Setup screen

4. In the Experiment Name section, enter the test name.
a. Experiment Name: User-defined or 500003XMPDirExtpixlRev01

5. In the Channel section, select the dye and define the target identified in each channel.

a. Select Channel 1

i. From the drop-down menu select: FAM

ii. Name the Channel: RNaseP

b. Select Channel 3

i. From the drop-down menu select: ROX

ii. Name the Channel: CoV2-N1

c. Select Channel 4

i. From the drop-down menu select: Cy5

ii. Name the Channel: IAC

d. Integration Time for pixlTM Real-Time PCR Platform optimized tests are
recommended to remain set to: auto.

e. To name the wells by sample name, select the appropriate well and next to
“Name” rename well to whatever is desired for the experiment.

f. If necessary, a barcode scanner can be plugged into the USB port located
on the front panel of the instrument to facilitate sample ID capture.

6. Tap Next to go to the Cycling Program screen

7. Add, remove, or edit a stage or step.

8. Adjust the temperature and time of a stage of step, number of cycles, and data
capture step.

a. Ensure Auto Integration Time is selected

b. Within the section of the thermocycling parameters, an additional step will need

to be added by selecting the “+” next to “Const-tempe Stage”.

c. Starting at the first “Pre-Denat” stage enter the following parameters (Table F2)

i. Pre-Denat: Step 1

1. 46°C
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2. 600 seconds

ii. Pre-Denat2: Step 1

1. 95°C

2. 150 seconds

iii. Cycle Period: Step 1

1. 95°C

2. 5 seconds

iv. Cycle Period: Step 2

1. 59°C

2. 12 seconds

v. Hold: Step 1

1. 50°C

2. 60 seconds

d. Save the template file before starting the run by clicking “Save Template” in the

upper right corner.

Table F2: pixlTM Real-Time PCR Platform thermocycling summary: Extracted Patient

Samples.

PCR Cycle Summary

Pre-Denat Stage Cycle Period Stage Hold Stage

Conditions Step 1 Step 2 Step 1 Step 2 Step 1

Temperature (°C) 46 95 95 59 50

Duration (sec) 600 150 5 12 60

Image Step No No No Yes No

No. of PCR Cycles 1 1 40 1
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9. Start Run

a. Select Start in the bottom right corner of the touchpad, this will

automatically take you to the “Run” tab

10. After run completion, navigate to the “Results” tab and select the appropriate

test to set the threshold for each channel used

a. Set Ct Low Limit to 13

b. Set Ct Threshold(%) to 6.0

11. Save Results File (Report tab)

a. In the upper right corner, select “Export” to save .json file, name file as

desired or “500003XMPDirExtpixlRev01”

b. Insert a USB key in the USB port located on the front panel of the

instrument to save the results file

c. Select “CSV” to save the file as an excel document

d. Select “PDF” to save the file as a PDF document

e. Select “JSON” to save the file as a JSON document
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pixlTM Real-Time PCR Platform - Thermocycling Programing

Direct Pooled Patient Sample (40 μL reaction volume)

Please refer to the following steps for pixlTM Real-Time PCR Platform touchpad manual

programming specific for Direct Pooled patient sample testing.

1. Open the “BioGX qPCR” pixlTM Real-Time PCR Platform app

2. Select “Test” on the left side home screen

3. Within the “Test” screen, tap “New Experiment” to proceed to the Sample Setup screen

4. In the Experiment Name section, enter the test name.
a. Experiment Name: User-defined or 500003XMPDirExtpixlRev01

5. In the Channel section, select the dye and define the target identified in each channel.

a. Select Channel 1

i. From the drop-down menu select: FAM

ii. Name the Channel: RNaseP

b. Select Channel 3

i. From the drop-down menu select: ROX

ii. Name the Channel: CoV2-N1

c. Select Channel 4

i. From the drop-down menu select: Cy5

ii. Name the Channel: IAC

d. Integration Time for pixlTM Real-Time PCR Platform optimized tests are
recommended to remain set to: auto.

e. To name the wells by sample name, select the appropriate well and next to
“Name” rename well to whatever is desired for the experiment.

f. If necessary, a barcode scanner can be plugged into the USB port located
on the front panel of the instrument to facilitate sample ID capture.

6. Tap Next to go to the Cycling Program screen

7. Add, remove, or edit a stage or step.

8. Adjust the temperature and time of a stage of step, number of cycles, and data
capture step.

a. Ensure Auto Integration Time is selected

b. Within the section of the thermocycling parameters, an additional step will need

to be added by selecting the “+” next to “Const-tempe Stage”.

c. Starting at the first “Pre-Denat” stage enter the following parameters (Table F3)

i. Pre-Denat: Step 1

1. 46°C
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2. 600 seconds

ii. Pre-Denat2: Step 1

1. 95°C

2. 150 seconds

iii. Cycle Period: Step 1

1. 95°C

2. 5 seconds

iv. Cycle Period: Step 2

1. 59°C

2. 12 seconds

v. Hold: Step 1

1. 50°C

2. 60 seconds

d. Save the template file before starting the run by clicking “Save Template” in the

upper right corner.

Table F3: pixlTM Real-Time PCR Platform thermocycling summary: Pooled Direct Patient

Samples.

PCR Cycle Summary

Pre-Denat Stage Cycle Period Stage Hold Stage

Conditions Step 1 Step 2 Step 1 Step 2 Step 1

Temperature (°C) 46 95 95 59 50

Duration (sec) 600 150 5 12 60

Image Step No No No Yes No

No. of PCR Cycles 1 1 40 1
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9. Start Run

a. Select Start in the bottom right corner of the touchpad, this will

automatically take you to the “Run” tab

10. After run completion, navigate to the “Results” tab and select the appropriate

test to set the threshold for each channel used

a. Set Ct Low Limit to 13

b. Set Ct Threshold(%) to 6.0

11. Save Results File (Report tab)

a. In the upper right corner, select “Export” to save .json file, name file as

desired or “500003XMPDirExtpixlRev01”

b. Insert a USB key in the USB port located on the front panel of the

instrument to save the results file

c. Select “CSV” to save the file as an excel document

d. Select “PDF” to save the file as a PDF document

e. Select “JSON” to save the file as a JSON document
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APPENDIX G

Bio Molecular Systems Mic Instrument - Thermocycling Programing

Direct Patient Sample (20 μL reaction volume)

Please refer to the following steps for Bio Molecular Systems Mic Instrument manual
programming specific for Direct Patient sample testing.

1. Launch the Mic PCR software.

2. In the top left of the software, select “New”

a. Select “Assay”

3. Select the “Information” tab on the banner on the left side of the software.

4. Under “Chemistry type” select “Hydrolysis Probes”

5. In the “Targets” section:

a. Enter “RNase P” as the first target and select FAM as the Reporter Dye

b. Enter “N1” as the second target and select “Cal Fluor 610” as the

Reporter Dye.

c. Enter “IAC” as the third target and select “Q670” as the Reporter Dye.

6. The remaining fields in the “Information” tab do not need to be populated.

7. Select “Profile”

a. On the top right of the software banner, select “Fast Taq” for the

Temperature Control.

b. Set the volume to 20 µL for direct sample addition testing.

8. Thermocycling programming parameters (Table G1)

a. Pre-Denat: Step 1

i. 46°C

ii. 1200 seconds

b. Pre-Denat2: Step 1

i. 95°C

ii. 300 seconds

c. Cycle Period: Step 1

i. 95°C

ii. 3 seconds

d. Cycle Period: Step 2

i. 62°C

ii. 20 seconds
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iii. Select the camera to turn on acquisition.

e. Cycle Period: Step 3

i. 70°C

ii. 5 seconds

f. Set the number of cycles to 40.

9. In the top left of the software select “Save As”

a. Name the file as desired. The file extension should be “.micassay”

Table G1. Bio Molecular Systems Mic Instrument thermocycling summary: Direct Patient
Samples.

PCR Cycle Summary

Pre-Denat Stage Cycle Period Stage

Conditions Step 1 Step 2 Step 1 Step 2 Step 3

Temperature (°C) 46 95 95 62 70

Duration (sec) 1200 300 3 20 5

Image Step No No No Yes No

No. of PCR Cycles 1 1 40
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Bio Molecular Systems Mic Instrument - Thermocycling Programing

Direct Patient Sample (15 μL reaction volume)

Please refer to the following steps for Bio Molecular Systems Mic Instrument manual
programming specific for Direct Patient sample testing.

1. Launch the Mic PCR software.

2. In the top left of the software, select “New”

a. Select “Assay”

3. Select the “Information” tab on the banner on the left side of the software.

4. Under “Chemistry type” select “Hydrolysis Probes”

5. In the “Targets” section:

a. Enter “RNase P” as the first target and select FAM as the Reporter Dye

b. Enter “N1” as the second target and select “Cal Fluor 610” as the

Reporter Dye.

c. Enter “IAC” as the third target and select “Q670” as the Reporter Dye.

6. The remaining fields in the “Information” tab do not need to be populated.

7. Select “Profile” tab located on the software banner.

a. On the top right of the software banner, select “Fast Taq” for the

Temperature Control.

b. Set the volume to 15 µL for direct sample addition testing.

8. Thermocycling programming parameters (Table G2)

a. Pre-Denat: Step 1

i. 46°C

ii. 1200 seconds

b. Pre-Denat2: Step 1

i. 95°C

ii. 300 seconds

c. Cycle Period: Step 1

i. 95°C

ii. 3 seconds

d. Cycle Period: Step 2

i. 62°C

ii. 20 seconds

iii. Select the camera to turn on acquisition.

e. Cycle Period: Step 3

i. 70°C
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ii. 5 seconds

f. Set number of cycles to 40.

9. In the top left of the software select “Save As”

b. Name the file as desired. The file extension should be “.micassay”

Table G2. Bio Molecular Systems Mic Instrument thermocycling summary: Extracted
Patient Samples.

PCR Cycle Summary

Pre-Denat Stage Cycle Period Stage

Conditions Step 1 Step 2 Step 1 Step 2 Step 3

Temperature (°C) 46 95 95 62 70

Duration (sec) 1200 300 3 20 5

Image Step No No No Yes No

No. of PCR Cycles 1 1 40
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REVISION HISTORY

Revision Date Description of Change

09 07APR2023 Update of real-time PCR platform names and typographical edits.

08 13JAN2023 Update name “BioGX pixl.16” to “pixlTM Real-Time PCR Platform”

07 22SEP2022 Update Table 1A and 1B regarding N1 gene and IAC Expected Ct values

06 19AUG2022
Update of BioGX pixl.16 run file names to 500003XMPDirExtpixlRev01
and remove all references regarding US FDA-EUA product approval and
use of product in the United States.

05 20MAY2022

Update branding, Update with addition of BioGX pixlTM Real-Time PCR
platform for detection of direct addition of individual samples, detection
of nucleic acid extracted individual samples and detection of direct
addition of pooled patient samples, Update with addition of Bio
Molecular Systems Mic Instrument for detection of direct addition of
individual samples and detection of nucleic acid extracted individual
samples. Update with addition of Applied BiosystemsTM QuantstudioTM 5
(384-well) platform for detection of direct addition of individual samples
and detection of nucleic acid extracted individual samples. Update with
addition of BioGX pixlTM Real-Time PCR platform and consumables part
numbers, Update with addition of Bio Molecular Systems Mic Instrument
consumable part numbers, Update with addition of Applied BiosystemsTM

QuantstudioTM 5 (384-well) platform consumable part numbers, Update
temperature range of shipping condition, Update to eliminate storage of
rehydrated master mix, Update use of BioGX External Control for Direct
or Extracted Sample Testing for BioGX pixlTM Real-Time PCR platform,
Update Table 2, Update in-silico analysis section, Update Tables 7 and 8,
Correction to CalRed610 settings in Appendix E, Addition of Appendix F,
Addition of Appendix G

4.1 11OCT2021
Update Intended Use Section to indicate performance of test was not
evaluated with all circulating variants.

04 01APR2021

Update number of reactions (tests) per tube to number of reactions
(tests) per kit. Update Table 2 to simplify interpretation, Update to add
direct analysis of pooled patient sample, validated real-time PCR
instruments compatible with sample types, number of tests per sample
type, pooled sample set up, pooled LoD summary, Appendix A and
Appendix C.

03 10 FEB 2021

Update fluorophore utilized for IAC detection, addition of
nasopharyngeal wash/aspirates and nasal aspirate sample types, addition
of Applied BioSystemsTM 7500 Fast Dx and Bio-Rad CFX384 TouchTM

platforms, update BioGX Rehydration Water Part number to
800-0035-12, update use of Qiagen Viral RNA Mini Kit, update
comparator method (LineaTM COVID-19 assay), update clinical
concordance study.

02 18 NOV 2020

Update equipment and materials required but not provided section,
Update specimen preparation section, update positive control and
patient result interpretation, update limit of detection table, update
clinical performance, update reference section

01 09 OCT 2020 Initial Release
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SYMBOLS

Symbol Meaning Symbol Meaning

Catalog number Contains sufficient for <n> tests

CE mark of conformity In vitro diagnostic medical device

Do not reuse Temperature limitation

Batch code Keep dry

Caution Keep away from sunlight

Consult instructions for use Expiration date

Manufacturer Biological Risks

Control Authorized Representative

BioGX
1500 First Avenue, North, L136, Birmingham, AL 35203, USA
Phone: +1.205.250.8055
Fax: +1.205.449.8055
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